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Day One Page # 

1.  Overview 
 Reflective Questions:  

What is the difference between learning to use technology and learning how to 
teach with technology? 
What are your goals for this workshop? 

 

2. Student Login 
Reflective Question: 
What are advantages to having students login to the TI-Nspire Navigator System 
every day at the beginning of class? 

7 

3. The TI-Nspire™ Navigator™ Experience 
 Reflective Questions:  

How can this activity assist students to better understand multiple representations at 
a higher cognitive level? 

 How would you have helped your students reach the same understanding of 
multiple representations without using TI-Nspire™ technology? 

9 

4. TI-Nspire™ Scavenger Hunt – The Calculator Application 
Reflective Questions:  
How could the templates and other options available with the Calculator application 
enhance the analysis of patterns? 

 How could the options available with the Calculator application change the way we 
teach certain concepts? 

13 

5. Demonstration – Formative Assessment 
Reflective Questions:  
How can a question document be used to help teachers assess student 
understanding of scientific concepts? 

 How can a question document provide an opportunity for students to see if they are 
meeting the standards for your unit? 

15 

6. The River of Life 
Reflective Question:  
How can multiple data representations using the TI-Nspire technology help students 
better understand science concepts? 

17 

7. The TI-Nspire™ Navigator™ Classroom  
Reflective Questions:  
How was the “teacher” able to interact with the class using the TI-Nspire Navigator 
System? 

 How could these interactions engage students? 

25 
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8. Practice Using Assessment Documents 
 Reflective Question:  

How can a question document be used to help students assess their understanding 
of concepts? 

41 

9. Reflection 
Reflective Question:  
Which parts of the day’s activities have made you consider new approaches for 
teaching any of the discussed science topics? 

 

Day Two  

1. Overview 
 Reflective Question:  

How does teaching with technology provide opportunities for enhancing student 
learning? 

 

2. Class Capture Features for Science 
Reflective Questions:  
How can Class Capture and Live Presenter be used to assist students who may be 
unsure about how to interact with a TI-Nspire document? 

 How can Class Capture and Live Presenter be used to encourage students to “talk 
about” the science in a lesson? 

49 

3. Introduction to the Vernier DataQuest™ Application 
Reflective Questions:  

 What is the pedagogical importance of making predictions and writing them down? 
With the TI-Nspire Navigator System, when should student work be displayed with a 
name and when should it be displayed anonymously? 
How did Class Capture enhance this activity? 

55 

4. TI-Nspire™ Navigator™ Performance Reflection  
Reflective Questions:  
How can good distractors in multiple choice questions provide valuable information 
on student misconceptions? 
When writing test questions, how can considering possible student errors help us 
plan follow-up questions to help students remedy their errors and misconceptions? 

59 

5. Linking Data from the Vernier DataQuest™ Application 
Reflective Questions:  

 What are the advantages of graphing a scatter plot outside of the DataQuest app? 
 How could the use of the data sensors and DataQuest application facilitate the use 

of “real-world” data? 

63 
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6. Demonstration – Travel Distance 
Reflective Questions:  
How was the instructor able to interact with the class using the TI-Nspire Navigator 
System? 
How could these interactions engage students? 

67 

7. Inserting an Image into a TI-Nspire™ Document 
Reflective Questions:  
How could the ability to import images into TI-Nspire documents enhance student 
understanding?  

 How might the use of student-generated images promote engagement? 

69 

8. Practice Creating an Assessment Document 
Reflective Question:  
How can a graph or image be used to create a formative assessment? 

71 

9. Resources 
Reflective Questions:  
How does the Preview pane help you browse activities more efficiently? 
Where can you find additional support and resources? 

75 

10. Reflection 
 Reflective Question:  
 In what ways does TI-Nspire™ technology enhance conceptual understanding in 

the classroom? 

 

Day Three  

1. Overview 
Reflective Questions:  
What is the difference between teaching science to our students and presenting 
science to our students?  

 How can formative assessment guide us in knowing what students understand? 

 

2. The Portfolio Workspace 
Reflective Questions:  
Why are the skills explored in this activity important? 

 How do the Portfolio and Class Record options make it easy to include all students’ 
work in the analysis of class data? 

83 

3. Data Aggregation in the Science Classroom 
Reflective Questions:  
How can Quick Poll and Class Capture be used to formatively assess student 
understanding? 

 How might the use of the TI-Nspire™ Navigator™ System address students’ 
different learning styles and promote multiple problem-solving strategies? 

91 
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4. Create Your Own Assessment 
Reflective Questions:  
How can questions be used to engage students and teach science concepts? 

 How can questions help turn a Quick Poll question into a class exploration? 

95 

5. Demonstration of the PublishView™ Feature 
Reflective Questions:  
How does PublishView facilitate multiple representations and interconnectivity of 
problem situations? 

 How does PublishView assist teachers in planning and organizing lessons? 

 

6. Weaving in TI-Nspire™ Navigator™ 
 Reflective Questions:  

How will TI-Nspire Navigator affect planning a lesson for your students?  
 How can TI-Nspire Navigator affect student performance in your classroom? 

99 

7. Reflection 
Reflective Question:  
What are your next steps as you plan to incorporate the TI-Nspire Navigator System 
into your own classroom? 

 

Appendix  

A. Tip Sheet: Overview of Workspaces 103 

B. Tip Sheet: Adding Classes 109 

C. Tip Sheet: Managing Classes 111 

D. Tip Sheet: Basic TI-Nspire™ Handheld Skills 113 

E. Tip Sheet: Live Presenter 117 

F. Tip Sheet: Class Capture 121 

G. Tip Sheet: Quick Poll 127 

H. Tip Sheet: Sending Documents 135 

I. Tip Sheet: Collecting Documents 137 

J. Tip Sheet: Sending Documents via the Transfer Tool 141 

K. Tip Sheet: Send the Operating System via the Transfer Tool 143 

L. Tip Sheet: Modifying TI-Nspire™ Assessment Documents 145 

M. The Press-to-Test Feature 149 

N. TI-Nspire™ Navigator™ Skills Rating 151 

O. Ticket Outta Here 153 
 



 Student Login              
 TI PROFESSIONAL DEVELOPMENT 
 

 

©2013 Texas Instruments Incorporated 1 education.ti.com 

Objective 
• Participants will learn how students log in to a TI-Nspire™ 

Navigator™ class. 
 
TI-Nspire™ Navigator™ Features 
• Logging in to the TI-Nspire™ Navigator™ System from a 

handheld 

TI-Nspire™ Technology Skills:  
• Logging in as a student 
 
Tech Tips:  
• Make sure the font size on 

your TI-Nspire handheld is 
set to Medium.  

 
 
 
The TI-Nspire™ Navigator™ System uses both your computer and your students’ handhelds. Your 
computer and your students’ handhelds communicate through the TI-Nspire™ Navigator™ access point. 

You do not have to log in to communicate with your students’ handhelds; you can use the Transfer Tool 
to send or delete documents and/or operating systems on the students’ handhelds. However, if you plan 
to use Quick Poll, Class Capture, Live Presenter, or place documents in the Portfolio during the TI-Nspire 
Navigator class session, then you must log in student handhelds to the TI-Nspire™ Navigator™ network. 

 

1. On the teacher computer, within the TI-Nspire™ Navigator™ Teacher Software, press Begin Class. 

2. Turn on the handheld that is connected to a wireless network adapter (or locked in the cradle). You 
will notice the following icons on the handheld in the upper right hand corner. 

Icon Status Meaning 

 
 

Blinking The handheld is searching for an access point. 

 Solid with  The handheld has found an access point. 

 Solid 
The handheld is not communicating with the wireless network adapter. 
Detach the handheld from the wireless adapter, wait for the icon to 
disappear, and then reattach the handheld to the adapter. 

 Blinking The handheld is connected to the network and is ready to log in. 

 Solid The handheld is logged in to the network and is fully charged. 
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3. When the  icon appears solid in the upper right-hand 
corner of the handheld, a “Login to Class” dialog box will 
appear. 

• If the dialog box does not appear, have students 
press c > Settings > Login….  

4. When logging in for the first time, a network must be 
selected. Click the Network button, select the appropriate 
network from the Network drop-down field, and click 
Connect. 

• A network only needs to be selected once, not every 
time a handheld is logged in. 

5. Students will first enter their User Name, press e, and 
then enter their Password. 

• Passwords must be at least 3 characters. The 
teacher might have chosen the student password 
when setting up the class. 

 

 

 

 

 

6. Press ·, and the “Login Successful” dialog box will 
appear on the handheld. 
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Objective 
• Model a constructivist science lesson that uses many 

features of the TI-Nspire™ Navigator™ System. 
 

About the Lesson 
• Participants will take on the roles of students to 

experience a constructivist lesson on chemicals using the 
TI-Nspire Navigator System. 

• Participants will be exposed to the various components of 
the TI-Nspire Navigator System as directed by the 
instructor. 

 
TI-Nspire Navigator™ Features 
• Sending a document 
• Sending quick poll questions 
• Live Presenter 
• Class Capture 
• Reviewing class results 
• Saving results to the Student Portfolio 

 
 
 

 

 
 
TI-Nspire™ Technology Skills:  
• Logging into the TI-Nspire Navigator 

System 
• Answering and Submitting an Open 

Response (Explanation) Quick Poll 
• Opening a TI-Nspire document 
• Navigating a TI-Nspire document 
• Selecting an answer to a question 
 
Lesson Materials: 
Equipment 
• TI-Nspire Navigator System 
• One TI-Nspire handheld per teacher 

TI-Nspire documents  
• What_is_a_Chemical Poll.tns 
• Chemical_PreSurvey.tns 
• Is_it_a_Chemical_1.tns 
• Is_it_a_Chemical_2.tns 
• Is_it_a_Chemical_3.tns 
• The_Chemical_List.tns 
• The_Real_Chemical_List.tns 

 
Lesson on “Is it a Chemical?”  
As participants, you will act as students in a science classroom with a TI-Nspire Navigator System. The 
instructor will guide you through the log-in process, the opening of TI-Nspire documents on the handheld, 
the interaction with documents, the answering of quick poll questions sent through the TI-Nspire 
Navigator System, and interacting through the Live Presenter feature. 
This is a demonstration activity. You will have the opportunity to perform all the TI-Navigator tasks in 
subsequent activities in the workshop. Right now, focus on interacting with the lesson as a student, and 
notice the use of the TI-Nspire TI-Navigator Systems. The next activity will give you the opportunity to 
reflect on these uses and how they impacted the activity and the classroom. 

9



  The TI-Nspire™ Navigator™ Experience   
TI PROFESSIONAL DEVELOPMENT 

 

©2012 Texas Instruments Incorporated 2 education.ti.com 

 
“Is it a Chemical?” Activity 
This is a demonstration activity, but the steps for the activity are included for later use by the participants. 
 
1. IMPORTANT: Ask participants to choose one of their students from the recent past. Ask them to take 

part in this activity thinking, acting, and responding as that student at the beginning of the 
school year in a science class.  

2. Use Live Presenter (log a handheld in yourself) to show participants how to log in.  
3. Have participants log in to the class. 
 
Pre-Assessment Quick Poll 
4. Open the diagnostic assessment, What_is_a_Chemical_Poll.tns, and click “Start Poll.” 
5. Use Live Presenter to show participants how to answer the quick poll and submit their answer. 
6. Click “Stop Poll” when everyone has completed it and quickly review the class results with discussion 

where necessary. Remember, this is a pre-assessment to help teach the upcoming lesson. 
 
Sending and Collecting a Document 
7. Send the participants the document Chemical_PreSurvey.tns. Use Live Presenter to show them how 

to access the document, answer a multiple choice question, and move from one page to the next. 
Ask participants to press / ` when they are done with the survey. Use Class Capture to monitor 

progress. 
8. Collect the results of the document, delete the document from the participants’ handhelds, and save 

them to the Student Portfolio. Briefly review the Class Results of the survey with the group. 
 
Quick Poll Yes or No 
9. Explain to the group that you are going to send them three quick poll questions to determine if 

specific substances are or are not chemicals (or made of chemicals). After each question, 
participants will defend the reasons for their choices. Also, remind them that they should answer 
these questions thinking like their student that they chose at the beginning of the lesson!!!  

10. Open the file Is_it_a_Chemical_1.tns, and click “Start Poll” for the first question. Let the participants 
see the live results of the poll. After most of them have answered the question, click “Stop Poll” and 
engage the participants in a discussion about the reasons for their choices. Take time to thoroughly 
discuss the question and elicit different points of view about why they said “yes” or “no.” Tell them 
that they should listen to the discussion to either strengthen or modify their personal definition of a 
“chemical.” Repeat the process for the questions on Pages 1.2 and 1.3. 
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Quick Poll Drag-and-Drop 
11. Explain to the group that you are going to send them a different list of substances, and they will have 

to determine if they are or are not chemicals (or made of chemicals). 
12. Send them Is_it_a_Chemical_2.tns, and ask them to drag the names to the “Chemical” or “Not a 

Chemical” side of the screen. (Using Live Presenter, use your own handheld to show participants 
how to pick up, drag, and let go of the names.) Consider making one or more participants the Live 
Presenter and ask them to explain why they are moving a name to one column or another. Also, use 
Class Capture to monitor progress. 
 

Quick Poll Multiple Responses 
13. Explain to the group that you are going to send them a final list of substances that they will have to 

determine if they are or are not chemicals (or made of chemicals). They will also be asked to defend 
their choices in a class discussion once all of the results have been collected. 

14. Send them Is_it_a_Chemical_3.tns. (Using Live Presenter, use your own handheld to show 
participants how to answer a multiple response question.) Use Class Capture to monitor student 
progress, and ask the participants to press / ` when they are done. 

15. Collect the results of the document, delete the document from the participants’ handhelds, and save 
them to the Student Portfolio. Review the Class Results of the survey with the group. Take time to 
thoroughly discuss each item and elicit different points of view about why they said the substances 
are or are not chemicals (or are made of chemicals). Remind them that they should listen to the 
discussion to either further strengthen or modify their personal definition of a “chemical.” 

 
Review and Discussion 
16. Now it’s time for the big reveal. Tell them that you will now show them which substances were 

chemicals (or were made of chemicals). Send them The_Chemical_List.tns. Ask them to read the 
document and discuss with them the implications of this list. (“How does it strengthen or change your 
definition of the word ‘chemical’?”) 

17. Somewhere in the discussion, act flustered, and say “Oh, I’m sorry, wait a minute. I’m sorry but I sent 
you the wrong file. Here is the correct file that shows which substances are made of chemicals.” 
Proceed to send them the file The_Real_Chemical_List.tns. After they have had a moment to look at 
the “real” file, discuss the impact of showing students The_Chemical_List.tns. 
• [Note: The_Chemical_List.tns states that 12 of the substances are chemicals (or are made of 

chemicals). That’s not a lie but it’s also not quite the whole truth. The_Real_Chemical_List.tns 
states that ALL 17 substances are chemicals (or are made of chemicals).] 
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18. If this took place in a real science class, there would most likely be some dissonance between the 
students’ definition of ‘chemical’ and their everyday view of the material world. Discuss with the 
participants how they would proceed at this point. 
• One possible strategy would be to discuss the common characteristics of all 17 substances. The 

teacher could also ask students what is not a chemical (or is not made of chemicals). Hopefully 
through this discussion, the teacher would guide students to reason that a chemical is any 
substance made of atoms or molecules. Also, they should discuss that forms of energy (i.e. 
sound, light, heat) or subatomic particles (i.e. electrons, protons or neutrons) are not considered 
to be chemicals. 

19. Mention to the participants that a potential wrap-up activity would be for students to complete the 
Chemical_PostSurvey.tns document. This is the same file as the Chemical PreSurvey.tns file so that 
overall changes in perception could be measured. 

Note: If this was a classroom situation with multiple classes using the same handhelds, it would be 
important to delete The_Chemical_List.tns and The_Real_Chemical_List.tns from the students’ 
handhelds so that future class periods would not already have the information. 

 
Some notes about The_Real_Chemical_List.tns: 
1) 4-hydroxy-3-methoxybenzaldehyde is the main ingredient in vanilla extract. 
2) Acetylsalicylic acid is the main ingredient in aspirin.  
3) Sodium hydroxide is the main ingredient in most oven cleaners. 
4) Sodium chloride is the chemical name for non-iodized table salt. (Iodized table salt also contains 
potassium iodide.) 
5) Ice, water, and steam are all different states of the same chemical. It’s important to note that steam is 
not visible to human eyes. 
6) Both a cookie and the smell from a cookie are made of chemicals. The smell is actually molecules 
leaving the cookie and entering your nose. 
7) Oxygen and gold are chemical elements. ALL elements are chemicals. 
8) Carbon is another element. Atoms of carbon can bond in different ways in the solid state which results 
in different forms (also called allotropes) of carbon. Some common allotropes of carbon are diamond, 
graphite, and charcoal. 
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Activity Overview 
In this activity, you will learn how to perform basic calculations in the Calculator application. You will also 
be introduced to various features and commands. 
 
 
1. Press c twice. There are three sections on the screen. In the bottom section, there are seven 

icons which represent seven different applications. Predict what these applications are:  
________________________________________________________________________________  

 
2. What happens to the screen when you press and hold / and then tap - several times? What 

happens when you tap + instead?  

________________________________________________________________________________ 
 
3. Open a New Document by using the Touchpad to move your cursor to New Document. Click by 

pressing x . If the handheld asks you, “Do you want to save?” answer ‘no.’ 
How did you answer “no”? _____________________________________ 

 
4. Select ‘Add Calculator’ by pressing ·. How else could you select it?  

________________________________________________________________________________ 
 
5. Press 6l5 and ·. How does the problem appear on your screen? ______________  

What is the answer? ___________ Press 28l and explain what happens when you press l.  
__________________________________________________________________________  
Where is the cursor located? _______________ Find 283 ___________________. 

 
6.  Find 362 __________. There is a quicker way to type 362 without using l. Instead we can use the 

q. Where is it located, and why is it faster this way? _____________________________________ 

 
7.  Type 3p8 and ·. What is the answer? _________  

Try 3p8 again, only this time press / and ·. What is the answer? _____________ 
One more time, type in 3p8, but this time include a decimal point at the end and then press 
·. What is the answer? _______________________________________________________ 

 
8.  Press / p. What appears on your screen? ________ Where is the cursor? ____________  

Type in 12, press e, type in 98, and press ·. 
What is the answer? _________ What did pressing e do? ___________________ 

 
9. Press £ once so the last answer is highlighted, and then press ·. What happens? 

________________________________________________________________________________ 
Press ¡ once. Where is the cursor? __________  
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Delete the current number by pressing .. Type in 28, and press ·. What is the answer? 

________________________________________________________________________________ 
 
10. Press £ several times, and then press ·. Try this a few times. What happens? 

________________________________________________________________________________ 
 
11. Press £ twice (to highlight the last problem you entered) and press ..  What happens? 

_______________________________________________________________________ 
Press . several more times. What is happening each time you press .? 
________________________________________________________________________________ 

 
12. Press / and £. What do you see? _____________  

Press .·. What does the screen say? _______________  

 
13. Press /0. This is a calculator screen, but what looks different about it? __________________ 

Now type in 3(5-8 and ·. What is the answer? __________  
You typed in 3(5-8, but what does the problem look like on the handheld? ________________ 

 
14. Press /q to get a square root. Then type 23-7, move one space to the right, and type 

+2·. What is the answer? ______  

What does the problem look like on the screen? _______________  
What happened to the square root bar? _____________  
Where did the cursor move when you moved one space to the right? ________________ 

 
15. Press (v17)q·. What is the answer? ______________ 

What makes the v button different from the - button? _______________________ 
 
16. Press c, and open a New Document. Select ‘No’ when it asks if you want to save the document. 

Press /c to turn off the handheld. These are the last things you should do on your 
handheld before you put it away each day! 

 
17. How can you clear your screen entirely? ______________________________________________ 
 
18. How can you recall the last answer? _________________________________________________ 
 
19. How do you know where you are typing on the Calculator screen? _________________________ 
 
20. How can you make sure your answer is in the form of a decimal and not a fraction? 

________________________________________________________________________________ 
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Objective 
• Demonstrate sending, collecting, and saving a TI-Nspire™ 

document with questions. 
 
TI-Nspire™ Navigator™ Features 
• Sending a document 
• Auto-Refresh of Class Capture 
• Collecting a document 
• Viewing class results 
• Saving to Portfolio  

TI-Nspire™ Technology Skills:  
• Logging into the TI-Nspire 

Navigator system 
• Opening a TI-Nspire 

document 
• Navigating a TI-Nspire 

document 
• Answering questions in a  

TI-Nspire document 

Assessment Activity 
Participants will be students in a classroom with a TI-Nspire™ Navigator™ System. ‘Students’ are 
asked a series of questions in a TI-Nspire document. The ‘teacher,’ your instructor, will use the 
Class Capture feature to monitor students’ progress through the assessment. 

When all students have completed the assessment, the teacher will collect the questions and 
immediately review the results with the class. After class, the teacher can compare the results to 
previous questions asked on an earlier day to monitor learning over a period of time. 

This is a demonstration activity. You will have the opportunity to perform all the TI-Navigator tasks 
in subsequent activities in the workshop. 

 
Notes for Today’s Activity 

These notes provide an overview of the activity, but they are not intended to describe all of the steps 
performed by the ‘teacher’ and ‘students.’ 

1. The teacher will start class and open the document Demo_FA_Math.tns, 
Demo_FA_MG_Science.tns, or Demo_FA_HS_Science.tns. 

2. Students log in to the class. One participant will wait and play the role of a student who comes to 
class late. 

3. The teacher sends the document to the class. 

4. The teacher monitors the documents being sent to the class.  

5. The teacher uses Class Capture of the entire class to assist students in opening the document. 

6. The teacher might use Live Presenter to review navigation of a document and answering questions. 

7. The teacher will ask the “late student” to log in to the class. Note: The “late student” still receives the 
document and can begin working. 
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8. The teacher uses the Auto-Refresh feature of Class Capture to monitor the progress of the class. 

9. Ask students to press /£ when they are finished. This makes it easy for the teacher to know 

when students have completed their assessment because all of the screens will be the same.  

Discussion Questions/Points:  

• Why did the teacher Class Capture the entire class? Class Capture will ensure that 
late students will be part of the Class Capture when they log in to the class, 
assuming that Auto-Refresh is used. 

• Why is Auto-Refresh useful? Students work at different rates. Class Capture with 
Auto-Refresh allows the teacher to monitor students as the class progresses. 

• Once a student finishes an assignment, what types of additional tasks can be 
assigned to keep the student engaged? One reason that students sometimes 
become discipline problems is that they have finished their work. If the teacher knows 
which students are finished with their work, they can be given another task while 
waiting for the rest of the class.  

10. When all students are finished, the teacher will discuss the types of questions that were included in 
the assessment and which ones can be graded automatically by the system. 

11. The teacher will collect the document using one of two methods: Click the Collect from Class icon, 
or right-click on the document name in the Class Record. 

• The “Collect from Class” method has the option to delete the file after collection. 

• Using the right-click method does not include the option to delete the file, but it can be deleted 
later by selecting the Delete from Class icon. 

12. The teacher can show the results in the Review workspace by right-clicking on the collection of the 
document in the Class Record. 

• The Page Sorter view in the Documents Toolbox allows navigation of the document and class 
results. 

• Correct answers appear in GREEN. If an answer is marked incorrectly, it can be adjusted. 

• Questions that aren’t auto-graded can be graded when viewing the results with the class. 

13. Save the collected results to the Portfolio by right-clicking on the document in the Class Record. 

Discussion Question: 

• Why would you want to save the document to the Portfolio? Saving to the Portfolio 
allows the teacher to compare student results with previous work by the student to 
monitor improvement in student understanding. 

 

16



  The River of Life Name   
TI PROFESSIONAL DEVELOPMENT Class   

 

©2012 Texas Instruments Incorporated 1 education.ti.com 

 
Blood is a body part that often gets overlooked because it is made, 
in large part, of liquid. This liquid portion of the blood is called the 
plasma, while the “solid” portion is made up of the blood cells. 
Later, you will have an opportunity to research what the different 
components of the blood do for you. For now, however, you will 
examine the relationship between the body weight and the blood 
volume of a human. Look at the data table below and discuss with 
a partner what you observe about the relationship between body 
weight and blood volume. 

 

 
 

 
1. Open the TI-Nspire™ document The_River_of_Life_MG.tns or 

The_River_of_Life_HS.tns. 

Press / ¢ and / ¡ to 

navigate through the lesson. 
2. On Page 1.3, look for any trends in the data of human body weight (in pounds) and human blood 

volume (pints of blood).  
3. Now, graph the data by inserting a Data & Statistics page. Press /~ and select Data & 

Statistics. 
4. Select weight as the y-value and volume as the x-value. 
5. Answer the questions on Pages 1.6 and 1.7. 
6. (Page 1.6) Estimate the weight (in pounds) of a woman who has 11.5 pints of blood in her body. 
 
7. (Page 1.7) Estimate the number of pints of blood that would be in a 200-pound man. 
 
8. Determine the equation of the line that represents the 

relationship between body weight and blood volume by 
analyzing the data. Press Menu > Analyze > Regression > 
Show Linear. Then answer the question on Page 1.10. 

 

9. (Page 1.10) Which equation expresses the correct relationship for the graph? 
  a) volume (in pints) = 12lb/pt * weight (in pounds) 
  b) weight (in pounds) = 12lb/pt * volume (in pints) 
  c) volume (in pints) = 12pt/lb * weight (in pounds) 
  d) weight (in pounds) = 12pt/lb * volume (in pints) 
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10. On Page 1.11, perform a Graph Trace by selecting Menu > Analyze > Graph Trace. Move the 

cursor left and right to get a better estimate of the answers to the original questions and then 
answer them on Pages 1.13 and 1.14. 

11. (Page 1.13) Estimate the weight (in pounds) of a woman who has 11.5 pints of blood in her body. 
 
12. (Page 1.14) Estimate the number of pints of blood that would be in a 200-pound man. 
 
13. Compare your answers from Pages 1.6 and 1.7 with Pages 1.13 and 1.14. 
14. Read Page 1.16 and 1.18 to determine an even better method of determining body weight and 

blood volume. Answer the questions on Page 1.17 and 1.19. 
15. (Page 1.17) Determine the weight (in pounds) of a woman who has 11.5 pints of blood in her body. 
 
16. (Page 1.19) Determine the number of pints of blood that would be in a 200-pound man. 
 
17. (Page 1.20) Your turn! How many pints of blood do you have in YOUR body? 
 
The remaining questions are a bit more challenging. See how many of them you can get right! 
 
18. (Page 1.22) How many pints of blood would there be in a person who had a weight of 

75 kg? (Hint: there are about 2.2 pounds in one kilogram.) 
 
 
19. (Page 1.23) If this weight/blood volume relationship were true for other animals, too, how many 

gallons of blood would there be in a horse that had a weight of 500 kg? 
 
 
20. (Page 1.24) Estimate the weight of a person who has two gallons of blood in her body. 
 
 
21. (Page 1.25) If you decided to donate blood at the blood bank, you would donate one pint. Using 

your own weight, calculate the percentage of your blood you would be donating. 
 
22. (Page 1.26) If 52% of your blood is water, what is the volume of water (in pints) circulating in your 

blood vessels right now?  
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23. (Page 1.27) Red blood cells are by far the most numerous cells in the blood, averaging 

about 4.5 x 106 cells per microLiter (1000 microLiter = 1ml; 1000ml = 1L). How many 
microLiter are there in one Liter? 

 
 
 
24 (Page 1.28) Using the information in the previous question, calculate the approximate 

number of red blood cells you have in your body right now. 
 
 
 
 
 
25. (Page 1.29) White blood cells (WBCs) are another type of blood cell in your body. 

Human blood contains about 7.0 x 103 WBCs per microLiter. Calculate the approximate 
number of leukocytes (WBCs) you have in your body right now. 

 
  

 

19



 

This page intentionally left blank 

 

20



 The River of Life  TEACHER NOTES 
TI PROFESSIONAL DEVELOPMENT 

 
 

©2012 Texas Instruments Incorporated 1 education.ti.com 

Science Objectives 
• Students will calculate the volume of blood in their own bodies.  
• Students will analyze and quantify some of the components of 

their blood. 
 
Math Objectives 
• Students will use tabular data to accurately generate a scatter 

plot. 
• Students will generate a linear regression model, use the function 

to perform calculations, and interpolate a value on the regression 
model. 

  
Materials Needed 
• TI-Nspire™ or TI-Nspire™ CAS handheld unit for each student  
 
Vocabulary 
• plasma 
• erythrocytes 
• leukocytes 
• milligram 
• microliter 
 
About the Lesson 
• This lesson involves generating a linear regression model for 

human blood volume vs. body weight. 
• As a result, students will: 

• Algebraically calculate their own blood volume. 
• Interpolate on the regression model to determine their blood 

volume. 
 

TI-Nspire™ Navigator™ System 
• Use Class Capture to monitor student progress. 

 
 

 
 
TI-Nspire™ Technology Skills:  
• Download a TI-Nspire™ 

document 
• Open a document 
• Move between pages 
• Entering and graphing data 

using multiple applications 
• Tracing, interpolating, 

predicting 
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Discussion Points and Possible Answers 
 

 
 

 
1. Open the TI-Nspire™ document The_River_of_Life_MG.tns or 

The_River_of_Life_HS.tns. 
2. On Page 1.3, look for any trends in the data of human body 

weight (in pounds) and human blood volume (pints of blood).   
3. Now, graph the data by inserting a Data & Statistics page.  

Press /~ and select Data & Statistics. 

4. Select weight as the x-value and pint as the y-value. 
5. Answer the questions on Page 1.6 and 1.7. 
 

Press / ¢ and / ¡ to 

navigate through the lesson. 

6. (Page 1.6) Estimate the weight (in pounds) of a woman who has 11.5 pints of blood in her body. 
  
Answer: Answers will vary. 

 
7. (Page 1.7) Estimate the number of pints of blood that would be in a 200-pound man. 

 
Answer: Answers will vary. 

 
8. Determine the equation of the line that represents the 

relationship between body weight and blood volume by 
analyzing the data. Press Menu > Analyze > Regression > 
Show Linear. Then answer the question on Page 1.10. 

 

9. (Page 1.10) Which equation expresses the correct relationship for the graph? 
  a) volume (in pints) = 12lb/pt * weight (in pounds) 
  b) weight (in pounds) = 12lb/pt * volume (in pints) 
  c) volume (in pints) = 12pt/lb * weight (in pounds) 
  d) weight (in pounds) = 12pt/lb * volume (in pints) 

 
Answer:    b) weight (in pounds) = 12lb/pt * volume (in pints) 
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10. On Page 1.11, perform a Graph Trace by selecting Menu > Analyze > Graph Trace. Move the 
cursor left and right to get a better estimate of the answers to the original questions and then 
answer them on Pages 1.13 and 1.14. 

11. (Page 1.13) Estimate the weight (in pounds) of a woman who has 11.5 pints of blood in her body. 
 
 Answer: Answers will vary. 

 
12. (Page 1.14) Estimate the number of pints of blood that would be in a 200-pound man. 

 
 Answer: Answers will vary. 

 
13. Compare your answers from Pages 1.6 and 1.7 with Pages 1.13 and 1.14. 
14. Read Page 1.16 and 1.18 to determine an even better method of determining body weight and 

blood volume.  Answer the questions on Page 1.17 and 1.19. 
 
15. (Page 1.17) Determine the weight (in pounds) of a woman who has 11.5 pints of blood in her body. 

 
 Answer: 138 pounds 

 
16. (Page 1.19) Determine the number of pints of blood that would be in a 200-pound man. 

 
 Answer: 16.7 pints 

 
17. (Page 1.20) Your turn!  How many pints of blood do you have in YOUR body? 

 
 Answer: Answers will vary. 

 
The remaining questions are a bit more challenging.  See how many of them you can get right! 
 
18. (Page 1.22) How many pints of blood would there be in a person who had a weight of 75 kg? (Hint: 

there are about 2.2 pounds in one kilogram.) 
 
 Answer: 15.6 pints 

 
19. (Page 1.23) If this weight/blood volume relationship were true for other animals, too, how many 

gallons of blood would there be in a horse that had a weight of 500 kg? 
 
 Answer: 11.4 gallons 
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20. (Page 1.24) Estimate the weight of a person who has two gallons of blood in her body. 
 
 Answer: 193 pounds  

 
21. (Page 1.25) If you decided to donate blood at the blood bank, you would donate one pint. Using 

your own weight, calculate the percentage of your blood you would be donating. 
 
 Answer: Answers will vary. Lower percentage for heavier people. 

 
22. (Page 1.26) If 52% of your blood is water, what is the volume of water (in pints) circulating in your 

blood vessels right now? 
 
 Answer: Answers will vary.  

 
23. (Page 1.27)  Red blood cells are by far the most numerous cells in the blood, averaging about 4.5 x 

106 cells per microLiter (1000 microLiter = 1ml; 1000ml = 1L). How many microLiters are there in 
one Liter? 
 
 Answer: There are 1 million (1,000,000 or 1x106) microLiters in one Liter. 

 
24 (Page 1.28)  Using the information in the previous question, calculate the approximate number of 

red blood cells you have in your body right now. 
 
 Answer: Answers will vary 

 
25. (Page 1.29) White blood cells (WBCs) are another type of blood cell in your body. Human blood 

contains about 7.0 x 103 WBCs per microLiter. Calculate the approximate number of leukocytes 
(WBCs) you have in your body right now. 
 
 Answer: Answers will vary 
 

TI-Nspire Navigator Opportunity: Class Capture can be used to monitor student progress. 
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Objective 
• Perform various TI-Nspire™ Navigator™ skills demonstrated in 

previous activities. 
 

About the Lesson 
• Participants will role-play in this activity as a teacher and/or a 

student. 
• The participant playing the role of the teacher will conduct a 

directed lesson using the features of the TI-Nspire Navigator 
System. 

• The participant playing the role of the student will perform the 
tasks of a student for the lesson. 

• Participants should then switch roles and repeat the process for 
another lesson. 

 

TI-Nspire™ Navigator™ Features 
• Setting Up a Class 
• Sending a Document 
• Class Capture 
• Live Presenter 
• Quick Poll 
• Student Portfolio 
• Student Data 

TI-Nspire™ Technology Skills:  
• Opening a TI-Nspire 

document 
• Navigating a TI-Nspire 

document 
 
Lesson Materials: 

Equipment 

• Computer with TI-Nspire™ 
Navigator™ Teacher 
software (for a pair of 
participants) with two USB 
ports 

• Two TI-Nspire™ learning 
handhelds per participant 

• Standard A to Mini-B USB 
Cables 

 

Roles 
Working in pairs, assign one role as the teacher and one role as the student. The “teacher” will operate 
the computer, and the “student” will operate two TI-Nspire handhelds. Participants will have an 
opportunity to switch and experience both roles. 

 

Instructions 
If a step below has Teacher in front of it, the participant operating the computer will perform the task. If 
the instruction has Student in front of it, the participant operating the TI-Nspire handhelds will perform the 
task. 
  

25



 The TI-Nspire™ Navigator™ Classroom                    
TI PROFESSIONAL DEVELOPMENT  

©2012 Texas Instruments Incorporated 2 education.ti.com 

Adding a Class 

1. Teacher: Open the Teacher Software on the computer by double-
clicking the Teacher Software icon on the desktop. 

• If necessary, close the Welcome Screen. 

2. Teacher: If necessary, open the Class workspace by clicking on 
the Class tab. 

3. Teacher: Select the Add Classes icon from the tool bar, or select 
Add Classes from the Class menu. 

4. Teacher: Click on NEXT to enter the class and students manually.  
• The process for uploading a CSV file to create classes is 

located in a tip sheet. It can be discussed at a later time. 
 

5. Teacher: Enter “Practice Class” as the class name and “3rd 
Period” as the section. 

• It is not necessary to complete the Section field. But it 
allows teachers to name classes by subject only (e.g. 
Algebra) and use the section field to distinguish between 
classes of the same subject (e.g. 3rd Period). 

 

  
 
 

 
 

  
 
 

 

6. Teacher: Click on the Add button.  

 

 

7. Teacher: Click Next. 
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Adding Students 

1. Teacher: To immediately add students to the class, click the Add 
Student button. 
• If the teacher closes the Class Wizard by clicking Finish, 

select the Add Student icon or select Add Student from the 
Class menu.  

  

2. Teacher: For each student below, enter the first name, last 
name, and user name into the Add Students window. Select Add 
Next Student to add another student. 
• Jon, Smith, Jon 
• Deb, Jones, Deb 
• Marco, Polo, Marco 
• Sonja, Perez, Sonja 
• Raymone, Tyson, Raymone 

3. Teacher: You can choose a password for each student, or each 
student can choose his or her own password when they log in to 
the class for the first time. 
• This will then be the student’s password unless the teacher 

chooses to reset it. 
• By default, the Display Name is the student’s first name. The 

Display Name can be edited as desired. 
• The Student ID is optional but sometimes important if you 

want to import grades into grade book software. 

4. Teacher: After the last student’s name is entered, click Finish. 

5. Teacher: To switch the student view between Seating Chart and 
Student List, use the Student View icons in the lower right corner 
of the software. 

 
 

 
 
 

 
 
 
 
 
 
 
 
 
 

 
Seating Chart 
 Student List 

Log in Students 

1. Teacher: Begin the class by clicking Begin Class. 
• Each student’s icon should change from light gray to light 

blue/yellow.  

2. Teacher: Connect both of the TI-Nspire handhelds to your 
computer using USB cables. One end goes into your computer’s 
USB port and the other into the TI-Nspire handheld.  
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Note:  In your classroom, each student’s handheld will not be 
connected to your computer in this way. They will each have 
their own wireless module that will communicate with your 
computer. 

3. Student: Turn on each handheld. 

4. Student: Log in a student on one of the handhelds. 
• The login window should pop up on the handheld’s screen. 
• If it does not, press c to access the Home screen, 

select 5 for Settings and 5 for Login. 

 
5. Student: Type jon as the username of one handheld, press ¤ 

on the Touchpad/Clickpad, type abc as the password, and press 
·. 

• You will see a message pop up on the handheld stating: “You 
are logged in as user: jon” 

6. Student: Press a to select the OK button. 

Note:  The passwords used can be the same for all students or 
unique to each individual. Some teachers assign everyone 
the same password so that they do not have to reset any 
passwords. Some teachers allow students to pick their own 
passwords. 

 
 
 
 
 
 

 
 
 

 
 
 
 

7. Student: Log in as deb on the other handheld.  
• If necessary, press c to access the Home screen, select 5 for Settings & Status and 5 

for Login. 
• Student: Type deb as the username of another handheld, press ¤ on the Touchpad/Clickpad, 

type abc as her password, and press ·.  

• You will see a message pop up on the handheld stating: “You are logged in as user: deb” 

8. Student: Press a to select the OK button. 

Send a Document 

1. Teacher: Click Send to Class. 

2. Teacher: Browse for the TI-Nspire document titled Density_of_Metals.tns provided for this 
activity in the location specified by your instructor. Click on the TI-Nspire document name 
so that it is highlighted.  

• Each person, when in the Teacher role, should use Density_of_Metals.tns. 
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3. Teacher: Click Finish to send the document to the 
handhelds. 

 
• You are able to send a document to specific individuals. However, the default is to send to the 

entire class. This is advisable because late students automatically get the document after they 
log in with minimal disruption.  

• You do not have to wait until the students log in before sending a TI-Nspire document. 
Documents can be sent any time after a class has been started.  

• On the handheld, all documents will be sent to a folder with the same name as the class (in this 
case, the Practice Class – 3rd Period folder). 

4. Teacher: Click on the 1st row in the Class Record. The row will 
turn blue, and you will see red and green student icons in the 
Classroom View. 
• A green icon indicates that the student has received the 

document; a red icon indicates that that student has not 
received the document. 

• Students with a red icon might be absent, or 
communication has been disrupted. 

• It is good practice to monitor the transfer of the documents 
sent to ensure that your students receive them. 

5. Student: Students know they have received a document 
based on the “Transfers Complete” pop-up window.  
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Open the Document 

Remember: The participant in the teacher role should be looking at the computer screen and not the 
handhelds. The participant in the student role should be looking at the screen of their handheld and not 
the computer screen. This is to model the classroom experience.  

1. Student: Pick one of the two handhelds and follow the Teacher’s 
instructions in step 2. 

2. Teacher: Say: “Open the document that was just sent to your handheld. To 
do this, Press · or x.” 

• If the handheld had a document open prior to opening this one, you 
would be asked to choose whether to save the prior document. Select 
No by pressing ¢ a. 

 
 

 

Class Capture and Live Presenter 

1. Teacher: Without looking at the student handhelds, press the Take Screen 
Capture icon and select Class Capture. 

2. Teacher: Click on the check box next to “Logged in only” to place a check 
mark inside. This will show screen captures for only those students that 
have logged in. Click OK to display the screens. 

3. Teacher: If the student only opened the document on one handheld as 
requested, the participant playing the role of teacher will notice that one 
student in the class has not opened the document.  

 

 
 

 
 
 

4. Teacher: Click on the check box beside Show Student Names, and observe the names appearing 
under the screenshots.  

  

Pause and Think About: 
i. Are there scenarios where you want to see the name with the screenshot of each handheld?  
ii. Can you think of a scenario where you would not want the names displayed?  
iii. If you notice that a student has not yet followed your instructions, how could you get the student 

back on track? 
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5. Teacher: Click on the one screen capture that does not have the first page of the document. It might 
be Jon’s or Deb’s handheld. 
• You want all students to properly process your verbal instructions. Class Capture can help you in 

this regard.  

How do you get this student back on track?  
• One strategy makes use of the Show Student Names feature within Class Capture to identify 

students that are having difficulty. Students close to them can help them get back on track. 
• Another strategy to get a student back on track is to make the student the Live Presenter and 

coach the student back. This is the strategy described below.  

 

6. Teacher: Click on the Screen Capture of the student who is not on the appropriate screen, and click 
the Make Presenter button. You can now view a live feed of the handheld belonging to that student. 
• You will see the student’s handheld on your computer screen.  
• The Live Presenter is a tool inside Class Capture that will show what the student is doing in real 

time. See Below. Note that you will see the handheld type used by the student according to the 
keypad they are using. This student is using TI-Nspire with touchpad.  

  
7. Student: Pick up the second handheld that has Deb logged into it, and follow the teacher’s 

directions. 

8. Teacher: Direct the student to press · or a on the handheld to open the document that was sent 

to the class. 
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Note: The teacher can customize the layout of the presenter. Currently, the default is to show the 
Handheld and Key Press History. You can turn off either or both of these views to customize the 
Live Presenter. You will see the key press history and the screen changing in real time. Notice on 
your computer software that you will see the specific buttons the student pushes identified by red 
outlines.  

 

  
Show Handheld and Key Press History Show Handheld Only 

 

  
Show Key Press View Only Neither Handheld Nor Key Press History 

 
Note:  One other important feature of Live Presenter is the ability to 

record keystrokes. Pressing Start Recording initiates the 
recording of an .avi video file. When you press Stop Recording, 
you will be prompted to save the .avi file in the Practice Class 
folder that exists on your computer.  

9. Teacher: Once this student has opened the document, click on the Stop 
Presenter button. 
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10. Teacher: Direct the student to interact with the document using the accompanying Student Activity 
handout (if applicable). 

11. Student: Interact as directed with the TI-Nspire document. 

12. Teacher: While students are working, monitor their progress with the 
Class Capture. Refresh manually or set up Auto-Refresh as desired  

 

Pause and Think About: 
 How could the use of Class Capture and Live Presenter change the way you can teach? 

Quick Poll 

1. Teacher: Close the Class Capture feature of the software on 
your computer. 

2. Teacher: Now, click the Quick Poll icon. 
• The Choose Question Type dialog box appears. 
• There are a variety of question types available: 

- Multiple Choice: Custom Choice, ABCD, True/False, 
Yes/No, Always/Sometimes/Never, Agree/Disagree, 
Strongly Agree… Strongly Disagree 

- Open Response: Explanation, Text Match 
- Equations and Expressions: y=, f(x)=, Expression 
- Coordinate Points & Lists: (x,y) Numerical Input, Drop 

Points, and List(s) 
- Image: Label, Point on 
- Chemistry 

3. Teacher: Select the Multiple Choice - Yes/No question type and 
press Insert.  

• A document titled “Practice Class – 3rd Period, QP Set 
1, DATE” opens in the Document workspace with a 
question page. 

• If desired, the question can be entered into the question 
field or it can be left blank and the question can be 
asked orally. 
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4. Teacher: Press the Start Poll button. 
• Assume that you are going to ask the following question orally to your 

class without the need for the question text.  
• Ask the student a yes/no question orally about the activity. 

 

 

Note:  Immediately after pressing the Start Poll button, the software opens to the Review workspace 
and creates a Review Poll document containing the Poll Question and Student Data. 

 
  

Question Field 

Poll Document 

Review 
Quick Poll 
Document 

Poll 
Question 

Student 
Data 
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5. Teacher: Monitor the number of incoming responses by 
watching the Student Data. 
• As the students begin to answer the poll, the numbers will 

change in real-time according to the number of students 
working on the question and the number of students who 
have submitted their answer. 

• Shown to the right is what a student sees on his or her 
handheld. All students have been sent the poll.  

 
6. Teacher: If this is the first time a student has been asked to 

respond to a poll, you might have to give instructions for 
answering a poll and submitting an answer. Tell the student:  

• “To answer the question, use the arrow keys to move to 
the Yes or No answer. Press the click key to “color” in 
the answer bubble of your choice.” 

• “To submit your answer, press the DOC button and 
select 1:Submit. 

• Alternatively, click on the down arrow to the right of the 
words Quick Poll at the top of the screen. Select 
1:Submit. 

• On a Clickpad handheld, press / c to open the 

Quick Poll pull-down menu.  

7. Student: Follow the teacher’s instructions to send student 
responses from each handheld to the teacher’s computer. On 
one of the handhelds, send Yes as the answer to the poll. On 
the other handheld, send No as the answer to the poll.  

8. Teacher: Monitor the Student Data, and click the Stop Poll 
button once you have received an answer from each handheld.  

• As the students begin to answer the poll, the numbers 
will change in real-time according to the number of 
students working on the question and the number of 
students who have submitted their answer. 
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9. Teacher: Click the Student Data icon, and note that the incoming answers have been collected and 
organized for you. 

 

  

Note:  By default, the “Allow Resubmit” option is turned off. This option allows students to resubmit their 
answers until the poll is stopped. When the “Allow Resubmit” option is turned off, then the student 
has only one chance to respond to the question and the poll will disappear as soon as the 
student submits an answer. 

 

10. Teacher: The “Allow Resubmit” option is located in the Documents 
workspace under the Tools > Quick Poll Options menu. Return to 
the Documents workspace, and select Allow Resubmit.  

 

 

Pause and Think About: 
When would you want students to Resubmit answers to a poll? 
When would you not want students to Resubmit answers to a poll? 
  

Student 
Data 
icon 

Show 
Correct 
Answer 
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11. Teacher: Type the text of another appropriate yes/no question for the activity in the Quick Poll 
Question page that is already open. 

12. Teacher: Press the Start Poll button.  

13. Student: Select a response, and submit it for both handhelds.  

• The Quick Poll window remains open on the handhelds since the teacher selected the Allow 
Resubmit option. 

14. Student: Change an answer on one handheld and resubmit. 

15. Teacher: Monitor the Class Results, and click Stop Poll once you have received answers from all of 
your “students.”  

16. Teacher: Click on the Student Data icon for Quick Poll 2 to see the student responses.  

17. Teacher: Click on the Students icon under the Review Toolbox to see each student’s response. The 
students’ names that are in red have not answered the poll. 

 

18. Teacher: Click on the check box beside Display Student Responses, and observe what happens. 
Notice all the responses are hidden, but the teacher knows who has responded. 

  

Pause and Think About: 
 i) How could you use this feature in your classroom?  
 ii) Are there times when you want or don’t want your students to see the responses?  
 iii) Is there pedagogical value in the information provided? 
  

Students 
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19. Teacher: In the Class Results display area, right-click on the bar 
representing the answer No, and select Mark this Response 
Correct.  
• The bar next to the word No will change to green to signify 

that it has been recorded as the correct answer if Show 
Correct Answer is selected.  

 

• This will allow the teacher to record and track the correctness 
of each student’s answer to the question posed. 

• If the correct answer to a question is never marked, the 
teacher can still gauge class understanding from the results, 
but the question will not be included in any scoring when the 
results are saved into the Student Portfolio.  

 

 
 
 

 

20. Teacher: Return to the Document workspace. 

21. Turn off the “Allow Resubmit” option by pressing Tools > Quick Poll Options. 

22. Teacher: Click the Quick Poll icon.  

 
 

 
23. Teacher: Select the Multiple Choice - Custom Choice type of 

question, and press Insert. 
24. Teacher: Click in the question field, and type an appropriate 

question for the activity. 
25. Teacher: Click in the first answer field, and type the first answer 

choice.  
26. Teacher: Using Tab or the down arrow, navigate to the second 

answer field. Type the second answer choice. 
27. Teacher: Press Enter to open an additional answer field, and 

type in a third answer choice. 
• To remove an empty answer field, click in that field, and press 

Backspace. 

 
 
 

 

Note:  If this process is not being completed in front of 
students, the teacher could mark the correct answer 
when writing the question. Open the Document Tools in 
the Documents Toolbox and click on the checkmark in 
front of the correct answer. 
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28. Teacher: Send the Quick Poll to the class by pressing Start Poll. 

29. Student: Answer the Quick Poll question on both handhelds, and submit the responses. 

30. Teacher: Monitor the incoming responses. If necessary, repeat instructions on how students submit 
a Quick Poll response 

31. Teacher: Click on the Stop Poll button after students have responded to the question. 
 

Saving to the Portfolio 
 
The Quick Poll questions and class results for a class session are compiled into one Review Document 
for up to 15 Quick Poll questions. If more than 15 Quick Poll questions are sent during a class session, 
another Review Document will open and compile the next 15 Quick Poll questions and results. These 
results can be saved into the Portfolio at any time during the class session. Saving the results will help 
the teacher monitor student progress over time and make diagnostic decisions regarding student 
performance. 
1. Teacher: Click on the X to close the Review Document containing 

the Quick Poll questions and class results, and click Save. 
Alternatively, select File > Save to Portfolio. 

 

 

 

2. Teacher: If desired, change the name of the portfolio column, and click Save. 
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3. Teacher: To view the portfolio, go to the Portfolio workspace. The 
Assignment Summary displays the results in a gradebook type display. 
• The portfolio will be discussed in depth in a later activity in the 

workshop. 
 

 
 

 

 
 
 
 
 
 
 
 

4. Teacher: To end the class, select End Class from the pull-down menu next to the Class Name. 
• If a pop-up window indicates ‘Active transfers are in progress,” press End Class. The alert 

indicates that the TI-Nspire document sent to the class is still available for those who have not yet 
logged in to the class session. 

  
 

Switch Roles 
 
Now switch roles and repeat the activity. When creating a new class, be sure to use a different class 
name and select that class name before starting the class. 
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Objective 
• To become more familiar with the available type of 

assessment questions for TI-Nspire™ documents. 
• To practice sending and collecting TI-Nspire documents.  
• To practice saving documents containing assessment 

questions to the Portfolio. 
• To practice opening class documents with assessment 

questions and reviewing the class results. 
• To provide a practice session for participants who have not 

previously created a class with TI-Nspire™ Navigator™ 
software. 

 
About the Lesson 

• Answer a variety of assessment questions on the TI-Nspire 
handheld. 

• The purpose of this activity is not to create the 
documents but to use them once they are created.  

 

TI-Nspire Navigator Features 
• Setting Up a Class 
• Sending a Document 
• Class Capture 
• Student Portfolio 
• Class Results 

 
 
TI-Nspire™ Technology Skills:  
• Opening a TI-Nspire 

document 
• Navigating a TI-Nspire 

document 
• Answering various question 

types in a TI-Nspire 
document 

 
Tech Tips:  
• To work with a TI-Nspire 

document that has been 
collected, right-click on the 
collected document in the 
Class Record. 

 
Lesson Materials: 

Equipment 

• Computer with TI-Nspire 
Navigator teacher software 
(for a pair of participants) 
and two USB ports 

• Two TI-Nspire handhelds 
per participant 

• Two TI-Nspire computer-
handheld cables per 
participant 

TI-Nspire document  
• Density_Questions.tns 
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Roles 
Working in pairs again, switch roles from the previous activity, “Density of Metals.”  The 
Teacher will only operate the computer, and the Student will only operate the TI-Nspire 
handhelds. Each participant will get an opportunity to switch and experience both roles. 
 
Instructions 
If a step below has the label Teacher in front of it, the participant operating the computer 
will perform the task. If the instruction has Student in front of it, the participant operating 
the TI-Nspire handhelds will perform the task. 
 
Note: If you were able to play both roles in the previous lesson (Teacher and Student), 

then you do not have to create a new class. You may start this lesson at step 4. 
 
1. Teacher: Start the TI-Nspire Navigator Teacher Software on 

the computer. 
2. Teacher: Create a class named Practice Class. 
3. Teacher: Add five students to your class. You can make up 

any names you want for this class (or use the names from the 
last lesson). 

4. Teacher: Change the display name for the students within the 
software using the “Display Name” options.  

• The change will affect all workspaces. 
5. Student: Connect both of your TI-Nspire handhelds to the 

computer using the USB cords provided. 
Note: If there is still an available USB connection or you are 

using a USB hub, the participant playing the role of 
teacher might also attach a handheld and log in so there 
will be more student results at the end of the session. 

6. Teacher: Begin class. 
7. Teacher: Send the document Density_Questions.tns to all 

students in the class.  
 
Questions for Thought: 

• Why do we want to send the document to all students? 
Why not only those who are logged-in? 
 

8. Student: Turn on each handheld. 
9. Student: Log in as one of the students in the class. 

 

 
 
 

 
 
 

 
*NEW* Display Name Option 
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Questions for Thought: 
• How do the students know they have received the document? 
• How does the teacher know who has received the document? 
• Where do you expect to find the sent document? At this point, make sure both of 

you easily find the sent file and the underlying file structure. 
 

10. Student: Open the Density_Questions.tns document. 
• Press c, and select My Documents. 

• Move the cursor down until you find the folder Second Practice Class. 
• Press · to open the folder. 
• Locate the document, and press · to load the file. 

• When you receive the message “Do you want to save changes to …” if you have 
saved the previous file or do not want to save the file, tab to “no,” and press ·. 

• You should see the title page of the document. 
11. Teacher: Monitor students using the Class Capture tool.  
12. Student: Go through the document answering all questions. 

 
Questions for Thought: 

• How do you move to the next page? 
• Make sure you make at least one mistake as you go through the two sample 

questions so you can see the difference between how correct and incorrect 
answers are shown in the slide show. Since Open Response questions do not 
self-grade, make the mistakes on the other type of questions. 

 
Note:   Later in the workshop, you will learn how to create these documents. 
 

13. Page 1.3 illustrates a True/False problem. 
• The cursor starts in the question box. Press e until 

you select the answer you want to choose. Press · 

to select that answer. Move to the next page. 
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14. Page 1.4 illustrates an Always/Sometimes/Never problem. 

• The cursor starts in the question box. Press e until 
you select the answer you want to choose. Press · 

to select that answer. Move to the next page. 

 

15. Page 1.5 illustrates a 4-option multiple choice question. 
• You navigate all question pages using the same 

techniques. 
• The circles preceding each option indicate there is 

only one correct answer for this question. 

 

16. Page 1.6 illustrates a 4-choice multiple choice problem where 
there might be more than one correct answer. 

• The square in front of the choice indicates multiple 
correct answers are possible. 

• To receive full credit for this type of problem, you must 
get all possible choices correct. 

  

17. Page 1.7 illustrates an open response question called text 
match. 
• Press e to move to the answer area. 

• Replace the question mark with a numerical value.  Be 
sure to keep the blank space between the value and the 
units ‘g/mL.’  

• If you make a mistake and need to reinsert the blank 
space, _, it is found at the bottom right on the alpha 

portion of the keyboard. 
• This type of open response question will be graded 

automatically if the student’s answer matches your 
answer exactly.  You may, however, mark other student 
answers as correct if there are slight variations in their 
work.  Just right-click on their answer bar in the Results 
section to mark it as correct. 
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18. Page 1.8 illustrates an open response question called 
explanation. 
• Press e to move to the answer area. 

• Type your answer in the answer box.  
• The blank space, _, is found at the bottom right on 

the alpha portion of the keyboard. 
• One difference between the open response 

(explanation) question type and all others is the system 
can grade the other question types if you mark the 
correct answer when you develop the assessment. It 
cannot grade an open response question automatically. 

• Continue to the next page. 

 

19. Page 1.9 is being used to send a message to the student.  
• What are some uses of a message page like this at 

the end of an assessment? 

 

20. Student: Once you come to the last page, you have finished the assessment.  Stop 
and wait for the teacher to collect your document. 

21. Teacher: Using the Class Capture tool, you know the class is finished when all screen 
captures show the last page of the document. 

Classroom Tip: An alternative to the last page would be to ask students to press / £ 
when they have finished answering the questions. This might be easier to distinguish in the 
Class Capture view of an entire class. An added benefit is the ability to determine that the 
student answered all questions. Notice in the fourth screen capture below there is an empty 
circle. The empty circle indicates that no answer has been selected. 
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Collecting the Document, Storing it in the Student 
Portfolio, and Viewing Class Results 
 
To Collect the Document 
1. Teacher: To collect the document, click on the Collect from 

Class icon. 
2. Teacher: Select the appropriate document from those listed.  
3. Teacher: Select Next at the bottom of the dialogue box. 
 

 
 

 

4. Teacher: With this method, you can choose to delete the file 
from the device once you have it collected. You can also 
choose to only collect from some members of the class. Select 
Finish at the bottom of the dialogue box. 
• You can select the document name in the Class Record, 

and the icon for each student will change color to show 
you which file transfers were successful. 

 

Question for Thought: 
• Discuss why you would want to delete the file and when you might want to leave it 

on the handhelds. 
 

 
 

To Save the Results in the Student Portfolio 
5. Teacher: Right-click on the document name in the Class 

Record section of the TI-Nspire Navigator software, and 
select Save to Portfolio.  
• Be sure to select the line with the file name being 

collected.  
6. Teacher: If desired, changed the name of the portfolio 

column. 
 
Note:   The student portfolio will be discussed in detail later in 

the workshop. 
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To Display Class Results 
7. Teacher: Right-click on the document name in the 

Class Record section of the TI-Nspire Navigator 
software, and select Open in Review workspace.  

 

 

8. Teacher: Using the Page Sorter View of the document, click 
on the Class Results icon to display the results for the 
associated question. 

  

 
 

Page Sorter 
View of 
Document 
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9. Teacher: Scroll through the page sorter view (or use the down arrows on the computer 
keyboard) to move through the document and display the class results. 
 

Question for Thought: 
• When you show the answer slide for Page 1.8, notice there are no green rows. Can 

you remember why? 
 

 
 
 
Switch Roles 
10.  Now switch roles.  Return to step 4 at the beginning of this activity, and repeat all of 

the steps. 
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Objective 
• Introduce additional features of the Class Capture 

tool of the TI-Nspire™ Navigator™ System. 
 

About the Lesson 
• Participants will act as students in a lesson looking 

for visual patterns in the graphs of data. 
• Participants will discuss the graph of time versus 

temperature for water changing from ice to steam. 
 
TI-Nspire Navigator™ Features 
• Class Capture 
• Live Presenter 

 
 
TI-Nspire™ Technology Skills:  
• Logging in to the TI-Nspire Navigator 

System 
• Creating a TI-Nspire document and 

adding Lists & Spreadsheet and Data 
& Statistics pages 

• Entering data into a List & 
Spreadsheet page 

• Creating a scatterplot on a Data & 
Statistics page 

• Changing the format of a plot 
 
Lesson Materials: 

TI-Nspire document  
• Class_Capture_Features_ 

Science_QP.tns 
 
Lesson on States of Matter  

Participants will act as students in a classroom with a TI-Nspire Navigator System. Once you have 
logged in, opened a new document, and added a Lists & Spreadsheet page, the instructor will assign 
you a “student scenario”. After entering your scenario data, you will add a Data & Statistics page and 
create an XY Line Plot. 

This is a demonstration activity. You will have the opportunity to perform all of the TI-Navigator tasks in 
subsequent activities in the workshop. Right now, focus on interacting with the lesson as a student, and 
notice the usage of the TI-Navigator System. 

 

Notes for Today’s Activity 

Notes are included here so that, in the future, the participant teachers can use them in their own 
classrooms with their own students. Participants will be referred to as ‘students’ here. 

1. Students will log in to the TI-Nspire Navigator session. 

2. Instruct students to open a new document and start with a Lists & Spreadsheet page. 
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Wait for further instructions once the Lists & Spreadsheet page is open. 

3. Use Class Capture to make sure that each student has a 
Lists & Spreadsheet page and is waiting to enter their 
“student scenario” data. 

• Show the Class Capture, and discuss any issues that 
might exist in a classroom at this point. 

• If you want, select one student to be the Live Presenter 
to demonstrate how to enter a list name and the data.  

• Continue to refresh the Class Capture until all screens 
are in the same location.  

 

4. Ask students to enter data for water changing from ice to steam using the following 
experimental procedure: 
“Imagine that a very cold ice cube is placed in a beaker. The beaker is put in an oven 
that supplies heat at a constant rate every minute. A sensor is used to monitor the 
temperature of the ice cube as it is heated. The ice is initially -40oC at t = 0 seconds. At 
70 seconds, the final temperature is 160oC.” 

• Students are asked to fill in the temperatures for ten second intervals between 0 
and 70 seconds. Students (participants) will be asked to intentionally enter data 
that displays common misconceptions found below. 

5. Student Misconceptions: 

Student A:  This student thinks the rate of change for the temperature will be constant. 

Student B:  This students knows that when the water is boiling, the temperature is constant, but 
thinks that the temperature is consistently rising during the melting phase. 

Student C:  This student knows that the temperatures during a phase change remains constant, 
but forgets that once the water has turned to steam the temperature will continue to 
rise. 

6. Refresh the Class Capture until all students have entered data. A portion of a sample 
Class Capture is shown below for discussion purposes. 

• When all students have successfully added their data, click the Add to Stack icon. 

 

50



   Class Capture Features for Science   
TI PROFESSIONAL DEVELOPMENT 

 

©2012 Texas Instruments Incorporated 3 education.ti.com 

Note:  If a participant enters data that does not meet the instructions, leave it until you 
discuss the graphs the first time. Having incorrect results provides an opportunity 
to discuss results that do not fit the requested pattern. In all likelihood, this is likely 
to happen in a real classroom. 

7. Ask students what patterns they see in the data. On the board or overhead, list all that 
are mentioned. Accept any idea, rearranging the screen to illustrate what is mentioned. 
For example, in response to “they have plateaus” you could rearrange the captures as 
illustrated below. 
Sample responses to the Class Capture above could be the following: “Some increase 
the entire time”. “Some go in steps”. Etc. 

 

8. Now the students will insert a Data & Statistics page and create a scatterplot with time 
along the horizontal axis and temperature along the vertical axis. 

• Take a Class Capture of the plots and discuss the results paying particular attention to patterns 
in the plots. A sample Class Capture is shown below. 

• Use Live Presenter to help if some students are behind. When all students have completed the 
task, click the Add to Stack icon. 
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9. As you are showing the Class Captures of the various patterns—after looking at all the 
screens together— select those that fit the pattern, and choose Edit > Compare 
Selected to allow a larger image to be viewed. Compare and contrast different plots of 
the data. 

• After each comparison, return to the Tiled view. 
• Click Add to Stack after all students are finished. 
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10. Ask each participant to grab and move his or her data points so that it reflects the 
learning from the discussions. 

• Refresh the Class Capture to make sure that all have successfully accomplished the task. Click 
Add to Stack whenever an interesting set of screens is displayed. 

• Make one person the Live Presenter, and allow that person to talk the group through the steps 
as necessary. 

 

11. Ask students to make a conjecture about the changes in the data as the plot has been 
changed. Give them a few minutes to examine the data. 

• What changes need to be made to the data to make the plot more accurate? 
• Set Class Capture to Auto Refresh every 30 seconds as they work. Click Add to 

Stack when an interesting result is captured. 

 

  

53



   Class Capture Features for Science   
TI PROFESSIONAL DEVELOPMENT 

 

©2012 Texas Instruments Incorporated 6 education.ti.com 

12. Next, review the lesson by examining the Captures that have been stored in the Stack.  

• Click on the drop down menu and select Frame 1. Scroll through all Captures stored during the 
lesson by clicking the Next Frame icon. This will allow the teacher to reflect on the lesson and 
identify students that need additional assistance. 

 

13. Your instructor will open the document Class_Capture_Features_Science_QP.tns next. 

• The teacher will send each Quick Poll and discuss the results. 
• Look at the various representations of the results, especially for the first question, the Multiple 

Response Custom Choice question. Also change the Data View for some of the Quick Polls. 

Note:  In the Class Workspace, go to File > Settings > Teacher Preferences to select or deselect 
Randomize order in Screen Capture.  

14. You will be asked whether you want to save the stacks when 
you close the Class Capture window. The default storage 
location is My Documents > TI-Nspire > Stacks. 
• Each Class Capture is saved as an individual .jpg file 

with the User Name, stack number, date, and time in the 
file name. 
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Objective 
• Introduce the features of the Vernier DataQuest™ application 

for the TI-Nspire™ handheld. 
. 

About the Lesson 
• Participants will use the data they collect to explain how the 

temperature sensor works. 
• Participants will learn how to change the time settings for 

other sensor experiments in the DataQuest application. 
 
TI-Nspire Navigator™ Features 
• Class Capture 
• Live Presenter 
• Quick Poll 

 
 
TI-Nspire™ Technology Skills:  
• Collect data with a 

temperature sensor 
• Use e to move within the 

DataQuest app 
 
Lesson Materials: 
• Vernier Stainless Steel 

temperature sensor 
• Vernier EasyLink® USB 

sensor interface 
 

Exploring DataQuest Using the Temperature Sensor 
1. In this activity you will perform a 30-second experiment to determine the effectiveness of the heat 

exchange in three different regions of the metal part of the temperature sensor.  Your instructor 
will assign you to collect data using either method A or method B.  

 Method A: 

1) Heat the bottom third of the metal part of the sensor for the first 10 seconds. 

2) Heat the middle third of the metal part of the sensor for the next 10 seconds.  

3) Heat the top third of the metal part of the sensor for the last 10 seconds. 

 Method B: 

1) Heat the top third of the metal part of the sensor for the first 10 seconds. 

2) Heat the middle third of the metal part of the sensor for the next 10 seconds.  

3)  Heat the bottom third of the metal part of the sensor for the last 10 seconds. 
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2. Turn on the TI-Nspire CX handheld by pressing c. 

3. Plug the temperature sensor into an Easy Link cable.  Plug 
the Easy Link cable into the top of the handheld.  (The 
DataQuest app should start automatically.  Note the 
information in the graph details box (the gray box at the left 
of the screen).) 

4. Select Menu > Experiment > Collection Setup. Press 
e to move through the field cells. 

5. Set the Rate (samples/second) to 1 and the Duration 
(seconds) to 30 s, and press ·. 

• How many temperature readings will the system collect?  Why 
does the number of data points vary from the duration of the 
experiment? 

 

 

6. Take a moment to sketch in the space below what you think the graph of temperature vs. time 
will look like for your assigned group.  Label some key points. 

 

 
 

 

 
 

 

 
 

 

 
 

7. When instructed to do so, click the Start button  and heat the three segments of the metal 
sensor as outlined for your group. (A: BottomMiddleTop     B:  TopMiddleBottom) 
Watch the graph develop as you go. The experiment will end automatically. 

• Does your graph look like your predicted sketch? Consider some of your labeled key points.   

• After collecting the data, use the Touchpad or e to move around the window and investigate 

the meter , the graph , and the table  tabs at the top left of the screen.  
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8. Share your graph with someone of the same group, and develop an explanation for the shape 
of the graph. 

9. Knowing what the other group’s procedure was, and having an explanation for your data, 
predict what you think the graphs from the other group will look like. Sketch your prediction 
here.  

      

 

 

 

 

 

 

 

 

 

 

 

 

10. Share your data graph with participants from the other group. Based on the results for groups 
A and B, determine the effectiveness of the heat exchange in each range (top third, middle 
third, bottom third) of the temperature sensor.  (What implications does this have for doing 
experiments with the temperature sensor?) 
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Objective 
• Reflect on actual student data accessible with the TI-Nspire™ 

Navigator™ System. 
 

About the Lesson 
• Participants will examine student data collected using the  

TI-Nspire Navigator System. 
• Participants will reflect on the results and attempt to identify 

misconceptions and determine remediation steps. 

 
 
 

Lesson Materials: 

TI-Nspire document  
• Navigator_Performance_ 
      Reflection_Science.tns 

 
Purpose of this Activity Reflection  

Participants will consider questions posed to a class and the answers provided by the class to discuss 
the course of action the teacher could take based on this real-time data of student understanding. 

 

Sample Student Response: Using Misconceptions to Engage Students 

 

 
 

 

 

Answer: Mass will be the same. 

 
What does this data tell the teacher about students’ understanding of conservation of mass? 

 

 

How might the data from the student responses be used by the teacher? 
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Sample Student Response: Remediation Questioning 

 

  

 

 

 

 

 

 

Answer:  All should be checked 
except for atoms. 

 
 

Note:   You are able to mark more than one answer correct in the class results, which can then 
be saved to the Portfolio. 

 

During a discussion with the class, which responses would the teacher “mark correct” and why? 

 

 

 

What discussion should happen around the incorrect responses? 
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Sample Student Response: Pre-Lab Questioning 

 

  

 

 

 

 

Answer:  All with 320 are correct. 

  
Are there any student responses that surprised you? 

 

 

 

What are the advantages and disadvantages to not providing choices for this question? 

 

 

 

 

How could the teacher use TI-Nspire to formatively assess after a lesson over conservation of mass? 
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Sample Student Response: Pre-Lab Questioning 

 

  

 

 

 

Answer:  You would see more of 
your face. 

 
Should the teacher have included any additional possible responses? 

 

 

 

Are there any student responses that surprised you? 

 

 

 

How might the data from the student responses be used by the teacher? 
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Objective 
• To practice using the Vernier® DataQuest™ application and 

linking the data to Lists & Spreadsheet and Data & Statistics 
applications. 
 

About the Lesson 
• Participants will complete an open-ended temperature 

activity to practice changing the settings in the Vernier 
DataQuest app. 

• Participants will learn how to link data from the Vernier 
DataQuest app to a Lists & Spreadsheet page and then 
create a Data & Statistics page to display their data. 

• Class Capture will be highlighted as a means to monitor progress 
and share data. 

 
TI-Nspire Navigator™ Features 
• Class Capture 
• Live Presenter 
• Quick Poll  

 
 
TI-Nspire™ Technology Skills:  
• Collect data with a 

temperature sensor 
• Link data between apps 
• Set up a Lists & 

Spreadsheets page 
• Set up a Data & Statistics 

page. 
 
Lesson Materials: 
• Vernier Stainless Steel 

temperature sensor 
• Vernier® EasyLink® USB 

sensor interface 
 
 

Linking Data 

1. Turn on the TI-Nspire handheld. 

2. Open a new document, and add a Notes page. 

• The Notes page will serve as the title page for your lab in this 
activity. 

3. Using the keypad, title this lab “Linking Data” 

4. Plug in the temperature sensor. 

5. Select Menu > Experiment > New Experiment. 

 

6. Now, think of ways that you can appropriately increase and decrease the temperature in a 2-minute 
time period. Perhaps you want to use hot and cold water. Maybe you want to collect data in the sun 
and then in the shade. Think about how often you want to collect data points; every second, one-
tenth of a second, every 2 seconds? 

7. Set up your time graph by selecting MENU > Experiment > Collection Setup. Now go collect your 
data! 
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8. After you have collected the data, use the touchpad to click 
x on the data line. A dotted, vertical line will appear. 

9. Use the arrow keys (¡ ¢ ) to scroll along the line and observe 
what happens to the data in the graph details box (gray box 
on the left containing the time and temp) 

10. Press / ~ to insert another Notes page. Type in a 
question you might ask your students about the data. 

11. The instructor will use the Live Presenter feature to share 
your data with the group. Be prepared to share how you 
collected your data. 

 
 

The data collected in the Vernier DataQuest app can be linked to the other apps in the TI-Nspire 
handheld. Follow along with your instructor to learn about how Lists & Spreadsheets and Data & 
Statistics pages can be linked with your data. 

12. Add a Lists & Spreadsheet page by pressing / ~.  

13. To link the data in the Vernier DataQuest app to this page, 
press £ on the Touchpad to move to the top of Column A. 

Be sure to move to the top of the column. 

14. Press  and select Link to > run1.time. 

15. Repeat in Column B only select run1.temperature.  

• This Lists & Spreadsheet page is not in the DataQuest 
app and can be used to analyze your data outside of the 
app. 

• The data can now be collected and aggregated using the 
TI-Nspire TI-Navigator System. 

 

 

16. Add a Data & Statistics page by pressing / ~.  

17. To choose the variable for the horizontal axis, move the 
cursor to the “Click to add variable” message at the 
bottom of the screen. Press x to display the variables. 

18. Select time for the X and temperature for the Y. 
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19. To add a moveable line to part of the scatterplot, press 
Menu > 4: Analyze > 2: Add Moveable Line. The 
regression equation will appear. 

20. Use the Touchpad and hand to drag and drop the line to the 
segment of data you want to analyze. Click and grab in the 
middle of the line to change the y-intercept. Grabbing near 
an end allows you to change the slope. 

• What happens to the regression equation as you move the line 
from the middle? From the end? 

 
 

Note: The moveable line feature is not available in the Vernier DataQuest app. 
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Objective 
• Model an inquiry-based lesson that integrates math and science 

using many features of the TI-Nspire™ Navigator™ System. 
 

About the Lesson 
• Participants will take on the roles of students to experience an 

inquiry lesson on travel distance using the TI-Nspire Navigator 
System. 

• Participants will be exposed to the various components of the 
TI-Nspire Navigator System as directed by the instructor. 

 
TI-Nspire™ Navigator™ Features 
• Sending a Document 
• Class Capture 
• Sending Quick Poll questions 
• Student Data 
• Review Workspace 
• Aggregating student generated data 

 
 
TI-Nspire™ Technology Skills:  
• Opening a TI-Nspire 

document 
• Navigating a TI-Nspire 

document 
• Collaboratively building a list 

of data to plot 
• Creating a scatter plot 

 
 
Travel Distance Activity 
This is a demonstration activity, but the steps are included here for later use by the participants in their 
own classrooms. 
 
1. Open the TI-Nspire document Travel_Distance_QP.tns. 

2. Start the Poll, and ask students to enter their estimated travel distance and time from their home to 
their place of work.  

3. After students submit their data, display the data in the List view. Right-click on the data, and select 
Send Table to new Document. 

4. Send the TI-Nspire document with the aggregated data to the participants. 

5. Ask a few Quick Poll questions: 

• Who traveled the farthest? 

• Who spent the most time en route? 

6. Ask students to set up a scatter plot using a Data & Statistics page. Use Class Capture to monitor 
their progress. 

7. Ask a Quick Poll question: What did you choose for the independent variable? 
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8. Have students find a line of best fit for the data or part of the data. Monitor progress with Class 
Capture. 

• It is possible that there will be one line that will fit the data; it is also possible that there will be 
more than one line that fits the data. 

• If all students drive, then there is probably one line to fit this data. If some students drive while 
others bike, it is possible to have different lines because of the different rates based on 
transportation. 

9. Ask some Quick Poll questions:  

• What method did you use for finding the equation? 

10. Challenge students to use a different method to find a line of best fit. 

11. Use a Quick Poll question to collect their equations and display their responses. 

12. Facilitate a discussion about the meaning of the slope and the y-intercept in the context of this 
problem. 

 Notes for Today’s Activity 
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Activity Overview 
In this activity, you will learn how to use the TI-Nspire™ family of Teacher Software to insert images into 
the Graphs and Geometry applications. You will also learn how to move, resize, compress, and stretch an 
image, as well as make it appear more transparent.  
 
 

Materials 
• TI-Nspire™ Teacher Software 

 
 
 

Step 1: 

Open the Teacher Software. If the Welcome Screen appears when the software is opened, 
click  to create a new document with a Graphs application as its first page. Otherwise, 
insert a Graphs application by selecting  Insert >  Graphs. 

Note:    Images can be inserted into Graphs, Geometry, Data & Statistics, Notes, and 
Question applications. 

Step 2: 

Insert an image into the Graphs application by selecting  
Insert >  Image. A selection of images is preloaded in the 
My Documents >TI-Nspire > Images folder. Select Ferris 
Wheel.jpg and click Open. 

Note:    Although the Teacher Software comes with a selection 
of preloaded images, all jpg, jpeg, bmp, and png images 
are supported. The optimal format is .jpeg 560 × 240. 
Larger images may take the document longer to load on 
the handheld. Images appear in grayscale for TI-
Nspire™ handhelds with Touchpads and Clickpads. 

 

 

Step 3: 

Images can be moved, resized, and vertically or horizontally 
stretched or compressed. To select an image in the Graphs, 
Geometry, or Question application, right-click on the image and 
choose Select > Image. To select an image in the Notes 
application, click the image. To move the image, grab and move 
the image. To resize the image, grab and move a corner. To 
vertically stretch or compress the image, grab and move the top 
or bottom edge. To horizontally stretch or compress the image, 
grab and move the left or right edge. 
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Note:    To right-click an object on a handheld, press /b. To grab an object, press 
/x. To let go of an object, press d. 

 

Step 4:  

To make an image appear more transparent, insert the image 
in a Geometry application, and then change the page to a 
Graphs application.  

Select  Insert >  Geometry. Then insert an image by 
selecting  Insert >  Image. Again, choose Ferris 
Wheel.jpg. To change the Geometry application to a Graphs 
application, select View > Graphing. 
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Objectives 
• Practice creating Custom Choice, Chemistry, and Open 

Response questions with TI-Nspire™ Navigator™ Teacher 
Software. 

• Practice saving TI-Nspire™ documents. 
• Practice sending, collecting, and saving documents to the 

Student Portfolio. 
• Practice opening and reviewing results in the Review 

Workspace. 
 
 
About the Lesson 
• Individually participants will use TI-Nspire Teacher Software to 

develop five assessment questions (simple multiple choice and 
open response) related to a solubility curve diagram. 

• Once questions are created, participants role-play the 
beginning classroom implementation of TI-Nspire Navigator in 
the assessment process through the use of TI-Nspire 
documents. 

 

 

TI-Nspire™ Teacher Software Features 
• Creating question pages in a document 
 
 
TI-Nspire Navigator™ Features 
• Sending, collecting, and saving documents to the Student 

Portfolio. 
• Displaying question results in the Review Workspace. 
 

 
 
TI-Nspire™ Technology Skills:  
• Creating a document containing 

assessment questions 
• Sending, collecting, and saving 

documents to the Student 
Portfolio 

• Showing Review Workspace 
results from an assessment 
question 

 
Tech Tips:  
• Save often while creating 

documents 
 
Lesson Materials: 

TI-Nspire document 
• Solubility.tns 
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Create the Assessment Document 
Participants should use the Teacher software to create five assessment questions in the document 
Solubility.tns. Participants may choose any of the question types highlighted in the last lesson. The 
assessment questions will focus on the following diagram: 

 
 
1. Open the document Solubility.tns using the TI-Nspire Teacher Software. 
2. Choose “Insert Question” from the toolbar. 
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3. Choose a question type, and click “Insert.”  
4. Type in the question. 

• Be sure to provide the correct answer in the toolbar to the left. 
• To insert the degree symbol, click on the Utilities button in the Documents Toolbox, select the 

Symbols tab, and double-click on the degree symbol. 

   

5. Choose “Insert Question” from the toolbar. Select “Chemistry.” Type in the question. 

 

Question: What is the formula of the salt that shows an increase in solubility of 40 grams / 100 
grams of water between 50 and 90˚C? 
Answer: K2Cr2O7 

 
6. Create three more questions related to the solubility graph so that you have a total of five 

assessment questions. Be sure to create at least one multiple choice question and one open 
ended (explanation) question. You might also want to add a Notes page at the end of the 
assessment that gives your students directions about what to do next. Your instructor will help you 
should you have any questions as you create your assessment document. Don’t forget to save 
your document once you are finished. 
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Roles 
Participants will continue the activity by working in pairs. The Teacher will only operate the computer, and 
the Student will only operate the TI-Nspire handhelds. Each participant will get an opportunity to switch 
and experience both roles. To create a more authentic classroom environment, the student should 
operate 2-4 handhelds. Another option is for the teacher to assist by operating a few handhelds. 

 

The Send/Collect/Save/Display Cycle 

1. Teacher: Start the class, and send the assessment document. 
2. Student: Log in to the class. 
3. Teacher: Instruct the students to open the appropriate assessment document and monitor 

progress using Class Capture. 
4. Student: Answer the questions in the assessment document. 
5. Teacher: Instruct the students to press / £ when they have finished the assessment. 

6. Teacher: Monitor student progress using the auto-refresh feature of Class Capture. When all 
student handhelds look like the screens below, you know the students are finished. 

 

7. Student: After all questions have been answered, press / £ and wait for the teacher. 

8. Teacher: Collect the document, and store to the Student Portfolio. 
9. Teacher: Open the results in the Review Workspace, and review the class results. 
10. Both: Switch roles, and repeat steps 1–9. 
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Objectives 
• Gain comfort with the Content Workspace of the TI-Nspire™ 

Navigator™ Teacher Software. 
• Investigate resources to support the use of the  

TI-Nspire™ Navigator™ System in the classroom. 
 
About the Lesson 
• Participants will visit websites containing resources supporting 

their TI-Nspire Navigator use in the classroom including: 
- Support for the TI-Nspire Student Software; 
- Support for the TI-Nspire Navigator System; and 
- Classroom-ready lessons. 

 
TI-Nspire™ Navigator™ Teacher Software Features 
• Browse for lessons at Math Nspired, Science Nspired, and 

TI Math 
• Preview and download lessons and documents  
• Send a document to the class or to an individual handheld 

through the Content Workspace 

 
TI-Nspire™ Technology Skills:  
• Preview lessons and 

documents using the 
TI-Nspire Navigator Teacher 
Software 

• Download a TI-Nspire lesson 
and document 

 
Lesson Materials: 
• Computer with Internet 

access and TI-Nspire 
Navigator Software 

 
Overview of Workspaces 

There are five different workspaces in the TI-Nspire Navigator Teacher Software: 

1. Content 
2. Class 
3. Documents 
4. Review 
5. Portfolio 

 
To move between the workspaces, click on the appropriate tab. 

 

Each workspace has a specific purpose, but they work together to create a complete package for the 
TI-Nspire Navigator classroom. Depending on the selected workspace, the menus, options, and icons 
will change appropriately. 

The focus of this activity will be the Content Workspace. Here, we will identify activities for the classroom, 
with brief use of the Documents Workspace, to interact with a downloaded activity. 
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Accessing Resources using the Software 

Access many online resources from within the TI-Nspire Navigator Software. 

1. Open the TI-Nspire Navigator Teacher Software. 

• If necessary, close the “Welcome Screen” by clicking the red X in the upper right hand corner.  

The software usually opens in the Documents Workspace, but we 
want to view locations for various content. Click on Content to open 
the Content Workspace. 

 

 

2. The Resources column on the left side of the window contains various resources broken down 
into three categories: Local Content, Links and Web Resources, and Connected Handhelds. 

• Local Content: Browse your computer, and create shortcuts to folders on your 
computer for easy access to your files. 

• Links (and Web Resources): Links to TI resource material and personalized links can 
be added and removed. 

• Connected Handhelds: Browse the documents of connected handhelds (This will not 
appear if no handhelds are connected.) 

Video Tutorials for the TI-Nspire Handheld, Software, and Navigator System 

1. Visit the Atomic Learning website by clicking Links in the 
Resources column, and then clicking the “TI-Nspire Tutorials” 
pre-loaded web address in the right-hand window 
(www.atomiclearning.com/k12/ti_nspire). 
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2. Upon arriving at the Atomic Learning website, you can view short 
video tutorials that highlight skills for the TI-Nspire handheld and 
computer software, including: 

• Creating and saving a new document 

• Finding and opening a document 

• Tracing a graph 

 

 

 

 

 

 

3. To view the available tutorials for TI-Nspire Navigator, click on 
the “TI-Nspire Navigator” link on the Atomic Learning website. 

4. You will be directed to a list of short video tutorials on TI-Nspire 
Navigator skills, including: 

• Creating a class 

• Starting a class session 

• Sending, collecting, and deleting documents 

• Using a Quick Poll 

• Using the Portfolio 

• Using Class Capture and Live Presenter 

Add a Personal Web Link 

1. While viewing the pre-loaded web links, click on the “Add Link” 
icon above the existing links. 

 

 

2. Type one of the following names and web addresses and click Add Link. 

• For Math Nspired, and web address is http://mathnspired.com. 
• For Science Nspired, the web address is http://sciencenspired.com. 

 
3. A new link is added to your list of web links. 

One of the reasons to add this website to your personal list of links is to easily gain access to 
additional video tutorials on TI-Nspire technology. By visiting the Resource Center selecting Video 
Tutorials, you will be directed to a multitude of videos related to interacting with TI-Nspire 
documents. 
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Pre-Made Lessons for Classroom Use 

1. Visit Math Nspired or Science Nspired using the link that was just created, and select a subject. 

 

 

Middle Grades Math, Algebra 1, Geometry, Algebra 2, 
Precalculus, Calculus, Statistics 

Life Science, Earth Science, Physical Science, Biology, 
Chemistry, Physics 

2. Select a unit from the list. A table appears with an image from each activity. The table contains links 
to download, recommend, and save each activity. It also identifies each activity type: 

 

Icon Type Description 

 
Bell Ringer 

Bell ringers are short lessons designed to help transition 
quickly into class after the bell rings. 

 

Action Consequence 
 

Simulation 

Interactive, engaging lessons allow students to perform 
actions on a mathematical object or scientific simulation, 
observe consequences, and make conjectures. 

Each lesson contains a pre-made TI-Nspire™ document, a 
Student Activity, and Teacher Notes. 

 
Create Your Own 

In addition to the Student Activity and Teacher Notes, the 
lesson also includes step-by-step instructions on how to 
create the TI-Nspire document. 

 

Data Collection with 
Probes 

Data Collection Labs give students the opportunity to collect 
and analyze real-world data with more than 50 data 
collection sensors from Vernier Software and Technology™. 

 

TI-Nspire™ Navigator™ 
Compatible 

The Teacher Notes identify opportunities to use the TI-
Nspire Navigator System, including opportunities for Quick 
Polls, Class Captures, and Live Presenter. 
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3. Select an activity from the table. Each activity page shows 
objectives, relevant vocabulary, and additional information about 
the lesson. A video offers a preview of the lesson, and related 
lessons are recommended. 

 

Icons above the Download section allow you to recommend, 
save, email, and print an activity. Links to Facebook and Twitter 
are also available. The Download section contains links to 
activity files. Links for Standards and Textbook Alignment and 
relevant Tech Tip Videos are also available. 

 

4. Select the Standards Alignment link on the left. Select a set of standards from the drop-down box, 
and click View Standards. A list of performance/content standards appears for each grade, along 
with a list of the relevant strands and performance indicators. 

 

5. Select the Textbook Alignment link on the left. Select a textbook from the drop-down box, and 
click View Textbooks. A portion of the textbook’s table of contents appears, which identifies the 
relevant chapter, section, lesson, and page numbers for the selected Math Nspired lesson. 
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6. If you visited Math Nspired, visit TI Math at http://timath.com. 

Additional lessons are available for Algebra 1, Geometry, 
Algebra 2, Precalculus, Calculus, and Statistics.  

Each activity has step-by-step instructions, a student handout, a TI-Nspire document, and a see-it-
in-action video of the TI-Nspire document. 

After you have decided on a subject area, be sure to change the device type to “TI-Nspire” and 
press FIND. 

 
Note:   You might want to add this link to your software links for easy access. 

Downloading and Previewing a Lesson 

To make a decision on the value of a lesson, the lesson must be previewed by the teacher. The 
Student Activity and Teacher Notes, as well as the TI-Nspire document, can be downloaded to the 
teacher computer. The Student Activity and Teacher Notes can be previewed at the website. 
However, to preview a TI-Nspire document (.tns file) beyond a video clip provided on the website, the 
file must be downloaded to the teacher computer. 

1. Select a lesson from the Math Nspired or Science Nspired website; and download the TI-Nspire 
document, Student Activity, and Teacher Notes separately. Save the documents to a location 
specified by your instructor. 

2. After the documents have been downloaded, go to the Content 
Workspace. Browse your computer using the Local Content 
area of the Resources panel to locate the lesson files.  

Note: Lesson files can be downloaded as one zip file. However, the files would need to be unzipped to 
be accessed in the Resources panel. 

3. Select the TI-Nspire document for the activity. 
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4. From within the Content Workspace, you will be able to preview the document using the arrows to 
scroll through the pages. 

 

 

 

 
5. To interact with the document, you will need 

to open the document. Right-click on the file, 
and select Open. 

• The document will open in the 
Documents Workspace. 

 

 

6. Using the TI-SmartView™ emulator in the Documents Toolbox, 
you can interact with the document as if you were viewing it on a 
handheld. 

 

 

 
 

 
 
 
 
 
 
 
 
 

Scroll through the pages 
of the document 

TI-SmartView 
emulator 
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Sending a Document From the Content Workspace 

1. Right-click on the document that is to be sent, then select Send to Class. 

If the Navigator class is running, the option 
Send to Class will be available. 
 

If the Navigator class is NOT running, the option 
Send to Connected Handhelds will be available. 

  
  
If you would like to send a document to one particular connected handheld, drag the file to the connected 
handheld listed in the Resources pane. 
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Objectives 
• Participants practice additional features of the Portfolio 

Workspace: modifying the answer key, changing student scores, 
sorting according to scores, excluding questions, previewing 
documents, and exporting the data. 

• Participants practice sending and collecting missing work for a 
student through the Portfolio Workspace. 

 
About the Lesson 
• In this lesson, participants learn about various features of the 

portfolio. In order to learn about these features, all participants 
will play the roles of Teacher and Student. 

• Pairs of participants will complete three simple assessments per 
student. 

 
TI-Nspire™ Navigator™ Features 
• Sending missing documents 
• Collecting missing documents 
• Editing Portfolio Workspace data 
• Exporting Portfolio Workspace data 

TI-Nspire™ Technology Skills:  
• Sending, collecting, and 

adding a missing student’s 
document to the Student 
Portfolio 

• Editing items in the Portfolio 
Workspace 

• Exporting data 
 
Lesson Materials: 

TI-Nspire documents  
• Element_Quiz_1.tns 
• Element_Quiz_2.tns 
• Lab_Safety_Quiz.tns 
• Density_of_Water.tns 

  
Preparing the Portfolio Workspace 
Work with a partner to share the handhelds for this section. 

1. Begin the class, and log in the two students Jon Smith and Deb Jones. Connect a handheld to your 
computer, and log in as Jon Smith. Have your partner connect a second handheld to your computer, 
and login as Deb Jones. Send the document Lab_Safety_Quiz.tns to the class and complete the quiz 
as stated below. 

Student Page 1.1 Page 1.2 Page 1.3 Page 1.4 Page 1.5 

Jon C C D B A 

Deb D B C D A 
 

2. Once the students have entered their answers for the quiz, collect the files from the class, delete the 
files from the handhelds, and save the results to the Portfolio. 

3. Now send the document Element_Quiz_1.tns to the class. Have Jon and Deb complete the quiz as 
noted below. 

Student Page 1.1 Page 1.2 Page 1.3 

Jon P So Tn 

Deb K Na Sn 
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4. As the teacher, collect the files from the class, delete the files from the handhelds, and save the 
results to the Portfolio.  

5. Send the Element_Quiz_2.tns document only to Jon Smith. Complete Jon’s quiz as noted below. 

Student Page 1.1 Page 1.2 Page 1.3 Page 1.4 

Jon Au P Mg Tu 
 

 

6. As the teacher, collect the file from the class, delete the file from the handheld, and save the results 
to the portfolio. 

7. Finally, send the file Density_of_Water.tns to each student.  On Page 1.2, have Jon graph volume (y-
axis) vs. mass (x-axis) and have Deb graph mass (y-axis) vs. volume (x-axis). 

8. Once finished, collect the file from the class, delete the file from the handheld, and save the results to 
the portfolio. 

9. End the class. 

You are now ready to learn about some of the features of the Portfolio Workspace. 

 

 

 

Adding a Missing Document to the Portfolio Workspace 
It is not unusual for a student to miss an assignment. If you are using the Portfolio Workspace as a 
location to store grades and monitor progress, you will want to add missing assignments. 

Deb Jones did not receive the Element_Quiz_2 assignment. Follow the steps below to send her the 
document, have her complete the assignment, and collect the document to include her grade in the 
portfolio. 
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1. Begin the class and have Deb log in to the class. 

2. In the Portfolio Workspace, click on the Column Actions drop-down 
menu for the missing assignment, and select Send Missing. 

3. Have Deb complete the document as noted below: 

 

  Page 1.1 Page 1.2 Page 1.3 Page 1.4 

Deb Hg P Mn W 

4. When Deb has completed the assignment, in the Portfolio 
Workspace, right-click on the name of the document, and select 
Collect Missing. 

Sorting Scores 

If you have a class size of 25 to 32, it can be difficult to quickly determine who is struggling and who is 
excelling on a particular assignment. In the Portfolio Workspace, you can sort the scores from high to 
low or from low to high in order to quickly observe patterns in student scores. 
1. Determine the assignment to be sorted in ascending or descending order. 

2. Click on the Column Actions cell for the selected assignment. 
3. Select Sort Ascending or Sort Descending. 
4. Select other assignments and practice this skill. 

 

5. To sort by the Display Name, click on the Assignment Summary label.  
• By repeatedly clicking on the Assignment Summary label, the ordering will rotate between 

alphabetical, reverse alphabetical, and alphabetical by last name. 

                

6. To sort by the Mean Score column, right-click on Mean Score, and select Sort Ascending/ 
Descending. 
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Grading a Document in the Portfolio 
A teacher can save a document in the portfolio for which some or all of the grading is based on non-
question pages. Perhaps the students were required to construct an object or graph and analyze data. 

In the Portfolio Workspace, the  icon in the cells 
for “Density_of_Water” indicates that a document 
was saved by the teacher that did not contain any 
Question pages. 

1. To preview and grade the document for each 
student, right-click on the  icon, and select 
Open for Editing. 

  
2. The student’s document will open in the Documents Workspace. 
3. After reviewing the student document and determining a grade, return to the Portfolio Workspace 

to enter a grade for the student work using one of the following two methods. 

4. To enter a final percentage only: Right-click on 
the  icon and select Edit Score. Enter the 
final percentage number for the assignment. 

 
 

 

5. To enter a grade based on points for the assignment: Select the assignment “Density_of_Water” 
from the Assignments pane. Click on the cell under “+Points,” and enter the Total Possible Points 
for the assignment. Then click on the cell for each student, and enter the points earned for the 
assignment. 
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Changing the Answer Key 

Follow the steps below to change an answer response that has been scored incorrectly. 
1. In the Portfolio Workspace from the Assignments Summary, click on the Column Actions cell for 

the “Element_Quiz_2” assignment. 
2. Select Open in Review Workspace. 
3. In the Page Sorter pane of the Review Workspace, 

scroll down to the question to be adjusted (Question 
Page 1.3), and click on its Student Data icon. 

4. Make the adjustments to the correct answer. (The 
correct answer, of course, is Sn not Tn.) 
• Right-click on the bars representing the correct 

answer, and select “Mark this Response Correct.” 
• The portfolio scores are automatically updated. 

5. Close the Review Workspace document.  
 
Editing a Student’s Score for an Entire Assignment 
Follow the steps below if you realize that a student’s score for an entire assignment is incorrect. 
1. In the Portfolio Workspace, right-click on the score to be changed, and select Edit Score. 
2. Type the new score, and press Enter. 
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Changing the Total Possible Points for a Question 
Follow the steps below if you decide that a question is worth more than the standard one point.  

1. Select the assignment “Lab_Safety_Quiz” in the Assignments pane. 

2. Click in the cell immediately below a question column (such as Q2), type 2, and press Enter.  

3. Select the appropriate option for the change, and click OK. 

 
 

Grading Student Responses from the Portfolio 
Follow the steps below to award credit for an open response question or to award partial-credit for 
student responses. 

1. Select the assignment “Lab_Safety_Quiz” in the Assignments pane. 

2. Click in the cell for a particular student for a question. The student’s response and correct answer 
will be displayed in the lower portion of the window. 

3. Give Jon Smith a partial score for his response to Q2, and press Enter. 
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Exporting Data from the Portfolio 
Some school grading programs accept data imported in CSV format. Follow the steps below to export 
portfolio data to a CSV file. 

1. From the Portfolio Workspace, go to File > Export 
Data > Custom Export. 

• If Export Current View is selected, the data 
displayed to the right of the Assignments pane will 
be exported.  

  
2. Select the assignment(s) data to be exported, and 

click Export. 

 
3. Determine an appropriate name and convenient 

location for the file. Click Save. 
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• Exporting when Assignments Summary is 
selected will result in a CSV file that contains final 
percentage scores only. 

 

 

 
• Selecting Export Current View when an 

individual assignment is selected will result in a 
CSV file that contains question details, total points, 
and final percentages. 

 

 

 
 

Reflection: 
• What makes the Portfolio Workspace more robust than a typical grade book?  
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Objective 
• Become familiar with the Data Aggregation with Lists 

technique using the TI-Nspire™ Navigator™ System. 
 

About the Lesson 
• Two activities will be conducted to explore the data 

aggregation technique. 
• The first activity will be instructor-led. The second will be 

hands-on with participants playing teacher and student 
roles. 

 

TI-Nspire Navigator Features 
• Quick Poll 
• Class Results 
• Lists & Spreadsheet 

 
 
TI-Nspire™ Technology Skills:  
• Answering questions related to length 

data 
• Submitting a Quick Poll response 
 
Tech Tips:  
• Data aggregation is accomplished by 

collecting data through a question 
page. 

• Aggregated data is sent back to the 
students through a document. 

 
Lesson Materials: 

• Computer with TI-Nspire Navigator 
Teacher Software  

• TI-Nspire Navigator access point 

• One TI-Nspire handheld per 
participant 

• One meter stick / tape measure for 
every 2-4 participants 

• Data_Aggregation.tns 
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Part 1 Activity 
The instructor will demonstrate how to use a TI-Nspire Navigator technique to collect, aggregate, and 
disseminate data. These directions are written from the instructor’s viewpoint as the ‘teacher’. 
1. Open the document Data_Aggregation.tns. 

• This file contains a LIST question that asks participants to record their gender, height (in 
inches), and arm span length (in inches) in Row 1. 

• Be sure to have enough meter sticks and/or tape measures for participants to use to measure 
their arm span length from the longest finger on their left hand to the longest finger on their 
right hand. 

2. Click START POLL. 
3. Click on the “working/submitted” box in the REVIEW tab to 

show the data table. 
4. Click STOP POLL. Right-click on the data 

table, and select “Copy Entire Table”. 
5. In the DOCUMENT tab, open a new TI-

Nspire document, and add a spreadsheet. 
6. With box A1 highlighted, paste your data into 

the spreadsheet. 
7. Label the columns with appropriate names. 

Clean up the spreadsheet. (Remove rows with 
dashes. Make sure that data is correct and uniform.) 

8. Save the document. 
9. Send the document to the students. Now they have a full 

set of class data ready to be analyzed! 
10. Instruct participants to add a Data & Statistics page to the 

document just sent to them and lead a discussion of trends in 
the data comparing different sets of variables. 

 
The following graphs are examples of ones that can be created and 
used for discussion: 
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Part 2 Activity 
Participants should work in pairs. One participant will act as ‘Teacher’ and the other one will act as 
‘Student’ using temperature data. The Student will operate two different handhelds connected to the 
Teacher’s computer. 
1. Teacher: Start the class. Create a poll question in which you ask 

the students to enter data in two columns labeled TempF and 
TempC. Send them the Quick Poll question. 

2. Student: Connect two different handhelds to the Teacher’s 
computer and log in. Enter the data below. Submit your data 
when you are finished entering it by pressing the DOC button on 
the handheld.  

Handheld #1 
Temp (˚F) 72 98.6 32 12 -40 

Temp (˚C) 22 37 0 -11 -40 
Handheld #2 

Temp (˚F) 212 85 53 120 -15 

Temp (˚C) 100 29 12 49 -26 
 

 
3. Teacher: When both student data sets have been entered, stop the poll, right-click on the data 

table, and select “Copy Entire Table”. 
4. Teacher: In the DOCUMENT tab, open a new TI-Nspire document, and add a spreadsheet. 
5. Teacher: With box A1 highlighted, paste your data into the spreadsheet. 
6. Teacher: Label the columns with appropriate names. Clean up the spreadsheet if needed. 

(Remove rows with dashes. Make sure that data is correct and uniform.)  
7. Teacher: Save the document. 
8. Teacher: Send the document to the students. Now they have a full set of class data ready to be 

analyzed! 
9. Teacher: Instruct the student (the other participant) to add a 

Data & Statistics page to look for the relationship between the 
temperature data. 

10. Student: Open the document that was just sent on one of the 
handhelds. Add a Data & Statistics page to look for the 
relationship between the temperature data. HINT: Use the MENU 
button and the ANALYZE feature.  
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SWITCH ROLES. 
The Teacher will now become the Student and the Student will become the Teacher. The two handhelds 
should now be disconnected from the computer and connected to the new Teacher computer. 
11. Teacher: Start the class. Create a poll question in which you ask 

the students to enter data in two columns labeled Inches and 
Centimeters. Send them the Quick Poll question. 

12. Student: Connect two different handhelds to the Teacher’s 
computer and log in. Enter the data below. Submit your data 
when you are finished entering it by pressing the DOC button on 
the handheld. 

 
Handheld #1 

Inches 1+1/2 4+15/16 8+1/2 17+7/8 

Centimeters 3.85 13.00 21.63 45.3 
Handheld #2 

Inches 2+5/8 11 12+1/2 35+7/8 

Centimeters 6.68 28.01 31.95 91.30 
 

 
13. Teacher: When both student data sets have been entered, stop the poll, right-click on the data 

table, and select “Copy Entire Table”. 
14. Teacher: In the DOCUMENT tab, open a new Nspire document, and add a spreadsheet. 
15. Teacher: With box A1 highlighted, paste your data into the spreadsheet. 
16. Teacher: Label the columns with appropriate names. Clean up the spreadsheet if needed. 

(Remove rows with dashes. Make sure that data is correct and uniform.)  
17. Teacher: Save the document. 
18. Teacher: Send the document to the students. Now they have a full set of class data ready to be 

analyzed! 
19. Teacher: Instruct the student (the other participant) to add a 

Data & Statistics page to look for the relationship between the 
length data. 

20. Student: Open the document that was just sent on one of the 
handhelds. Add a Data & Statistics page to look for the 
relationship between the length data. HINT: Use the MENU 
button and the ANALYZE feature.  
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Activity Overview 
In this activity, you will create an assessment document using the Question application of the TI-Nspire™ 
Navigator™ Teacher Software based on your own subject matter. You should try to incorporate as many 
of the question types as possible. Some hints will be provided for various question types. When you are 
finished, you might be asked to share your document with the rest of the group. 

 
 
Creating a Title Screen with an Image 

1. Open a new TI-Nspire document, and insert a Notes page.  

2. Click on the Page Layout icon  and choose the 
second layout. 

3. Click on the right side of the screen, and add another Notes 
page. 

4. Now, to finish off the title page, click on the left side, and 
type in a title for your assessment. 

5. Click on the right side and then click Insert > Image. 

• A sample page is shown to the right but you should 
create a title screen that relates to the subject matter 
that you teach. 

 

 

  

 

Creating Questions 

1. Add a question page by clicking Insert >  Question. Choose the type of question that you would 
like to create for your students. When choosing a question type, consider:  

• What type of assessment document is this?  

• Are you trying to uncover student misconceptions at the beginning of a unit?  

• Is this a summative assessment at the end of a unit?  

• Is this an assessment that focuses on a single topic or a broad range of topics? 

2. Try to choose as many of the question types as possible. 

3. Continue this approach until you are finished with your assessment. 

• Be ready to share your work with others and explain the rationale for the types of 
questions in your document. 
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Hints about Various Question Types 

Multiple Choice 

There are two main types of multiple choice questions – single 
response and multiple response. 

• Multiple response questions pose more of a challenge to 
students but the results are more interesting and more 
revealing about student understanding. Even though the 
button shape changes from a circle (single response) to a 
square (multiple response), it is still best to flag this type 
of question for students. Consider adding a statement like 
“Check all answers that apply” to your question text. 

 

 

  

Open Response - Explanation  

Open Response (Explanation) questions are great for getting an 
understanding of what students are really thinking since you’re 
giving them a blank canvas to “paint” their thoughts about a 
scientific concept. 

However, be aware that the students will need to type their 
responses using small buttons and a non-QWERTY keyboard. 
Try to narrow the focus of your question so that students need 
not write a lengthy essay to answer your question.  

With this type of question, you will be able to mark more than 
one response as correct during the Review session by right-
clicking on the answers. 

 

 

 

Open Response -Text Match 

Open Response (Text Match) questions can be used in a variety 
of ways. 

• First, consider using this question type to determine your 
students’ ability to recall important vocabulary. 

• Text Match questions are also good for quantitative 
problem solving.  

For example, if you asked students to find the mass of 32 mL of 
aluminum foil given a density of 2.70 g/mL, you could mark 86 g 
as the correct answer. You then have the option of marking 
multiple versions of that answer as correct. 

If you want to emphasize the importance of units and/or 
significant figures in an answer, then only 86 g (or possibly 86g) 
would be considered as correct. 
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Expression - Numeric 

The Expression question type can be used in a similar manner as 
the Text Match question to determine if students can find the 
numerical value of an answer in a quantitative problem. The 
advantage to this question type is that you have the ability to set a 
tolerance range of numerical values that are acceptable.  

For example, if you are just trying to find out whether or not students 
know that they need to multiply volume by density for the problem at 
the right, you might set the correct answer as 86.4 but input a 
tolerance of +/- 0.5. 

Note:  For this question type, be sure to select Number as the 
Response Type. 

 

 

 

Image Label 

This question type is a version of Text Match but gives you the 
option to include an image and move the answers to different 
locations on the screen. 

Once you have chosen this question type, insert an image, and 
move the answer boxes to the appropriate positions on the 
screen. 

Note:  To move an answer box, hover over it with the cursor 
until it turns into the white arrow as shown to the right. 
The white arrow might also change into the cursor that 
looks like a plus sign with four arrows. 

 

 

 

 

Image Point on 

This question type is a version of Multiple Choice but gives you 
the option to include an image and move the answers to different 
locations on the screen. 

Once you have chosen this question type, insert an image and 
then move the answer box to the appropriate positions on the 
screen. 

Note:  To move an answer box, hover over it with the cursor as 
shown to the right.  
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Chemistry 

This question type makes it easy for students to input subscripts and superscripts and element symbols with 
the correct case in chemical formulas with little effort. Here are a few hints for students to be successful with 
this question type: 

• Most chemical formulas can be typed “as is.” However, students might need to use the shift button to 
capitalize some element symbols. For example, cobalt is Co yet carbon monoxide is CO. Simply typing 
the letters c and o will result in the formula for cobalt. To type the formula for carbon monoxide, type C 
g O. 

• Superscripts are needed for ion formulas. Using the ^ button will allow the input of superscripts. For 
example, the symbol for the sulfate ion, SO4

2- , can be entered by pressing S g O 4 l 2 v. 

• The arrow indicating chemical change in a reaction can be entered by pressing the = button. 

• If you are using this question type to see if students are able to write a balanced equation for a chemical 
reaction you will need to enter all possible answers. For example, to write the balanced equation for the 
reaction of hydrogen gas with oxygen gas to produce water, you would need to enter both 
2H2+O2

2H2O and O2+2H2
2H2O as answers. 

• A Chem Box is a special text box that allows chemical formulas and equations to be easily entered into a 
Notes or Question application. A Chem Box uses a simple set of rules to adjust the formatting of 
subscripts and superscripts more easily.  

• To insert a Chem Box, select Document Tools > Insert > Chem Box. Alternatively, a Chem Box can be 
inserted using CONTROL+E (Windows) or COMMAND+E (Macintosh). 

 

Your Turn – Create Your Own Assessment 

Again, the purpose of this lesson is to give you some time to create an assessment that you might use in 
your classroom. Your instructor is here as a coach to help when you get stuck. Try to create a formative 
assessment, using as many of the question types as possible, that you could use with your students in your 
subject matter. Remember that you might be asked to share your work with others when you are finished. 
Have fun!!! 
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Objectives 
• Use the TI-Nspire™ Navigator™ System and explore how it 

can administer and enhance a classroom lesson. 
 

About the Lesson 
• Plan a TI-Nspire™ lesson that incorporates  

TI-Nspire Navigator features. 
 

 

TI-Nspire™ Technology Skills:  
• Opening a TI-Nspire document 
• Navigating a TI-Nspire 

document 
 
Tech Tips:  
• When you download an 

activity from the Content 
Workspace, the activity is 
downloaded as a lesson 
bundle with file extension 
.TILB.  

 
Lesson Materials: 

Equipment for each participant 
• Computer with TI-Nspire™ 

Navigator™ Teacher 
Software and Internet 
connectivity 

 
Select an Activity 

1. Use the Content Workspace to search through the available 
Web Content for an activity related to any concept you 
choose. 

• If Internet access is not available, browse the collection 
of activities in the folder for the workshop. 

 
 

 

2. Save the activity files to your computer.   
 

Review the Activity 

3. Familiarize yourself with the activity. Record any notes you have about the activity below. 
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Pre-test Considerations 

4. What specific questions are appropriate to activate prior learning? 

 

 

 

 

 

 

TI-Nspire Navigator Enhancements 

Think about some of the TI-Navigator functionality you have learned: 

• Sending and Collecting Documents  

• Screen Capture 

• Live Presenter 

• Quick Poll 

• Portfolio 

5. What TI-Nspire Navigator features could you use to improve this lesson? 

 

 

 

 

 

 

 

6. How can the use of TI-Nspire Navigator enhance your understanding of your students’ learning? 
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Post-test Considerations 

7. What specific questions are appropriate to assess whether the primary learning goals have been 
achieved? 

 

 

 

 

 

 

Wrap-Up with a Large Group Share 

Your instructor will guide a discussion related to the following questions. Be prepared to discuss your 
thoughts. 

8. How easy was it to weave TI-Nspire Navigator into this activity? 

 

 

 

 

 

9. What gave you the most difficulty/challenge? 
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TI-Nspire™ Navigator™ Objective 
• Differentiate between the different workspaces in the TI-Nspire™ Navigator™ Teacher Software. 

 

Overview of Workspaces  

There are five different workspaces in the TI-Nspire Navigator Teacher Software: Content, Class, 
Documents, Review, and Portfolio. To move between the workspaces, click on the appropriate tab. 

 

Each workspace has a specific purpose, but they work together to create a complete package for the 
TI-Nspire Navigator classroom. Depending on the selected workspace, the menus options and icons 
will change appropriately. 

Icons Available in All Workspaces 

  

The Student Name Format icon allows the teacher to change the 
displayed format of the students in a TI-Navigator class. The change 
will be reflected in all workspaces, including the Portfolio Workspace. 

 

  

 
Clicking the Take Screen Capture icon allows the teacher to 
take a class capture, capture a page of a document in the 
Documents Workspace, or take a screen capture of a connected 
handheld. The availability of the options depends on the state of 
the software and workspace. 

When Capture Page or Capture Selected Handheld is 
selected, a pop-up window appears in the lower right-hand 
corner allowing you to view the capture in the Screen Capture 
Window. The screen capture is also automatically placed into the 
computer’s clipboard and can be immediately pasted into other 
software, such as a word processing document. 

 

TI-Nspire™ Navigator System: 

 

TI-Nspire™ Navigator™ NC: 
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Clicking the Quick Poll icon allows teachers to create a new 
Quick Poll question at any time. The TI-Navigator Class does not 
have to be started, so a teacher can prepare questions before 
the class begins. It will be tagged with the name of the class that 
is displaying in the Class drop-down menu. 

 

 

 

  

The Content Workspace  

The Content Workspace is used for transferring TI-Nspire documents to/from the connected handhelds 
and the computer, for previewing documents, and for accessing documents on TI websites. 

Note:    When using the TI-Nspire™ Navigator™ NC Teacher Software, , the list of Connected 
Handhelds is not available  in the Resources panel. 

 

 

The Content Workspace allows the teacher to 
browse online TI activities without launching a 
web browser, to see an overview of the activity, 
to preview the TI-Nspire documents, and to save 
all the activity files to the computer. 

 

104



 Tip Sheet: Overview of Workspaces   
TI PROFESSIONAL DEVELOPMENT 

©2013 Texas Instruments Incorporated 3 education.ti.com 

 

With this functionality, the TI-Nspire documents can 
be sent directly to the class or any connected 
handhelds without opening any other software. 

Note:    When using the TI-Nspire™ Navigator™ 
NC System, any type of document can be 
sent to students’ computers. However, only 
TI-Nspire and PublishView™ documents 
can be opened using the TI-Nspire™ 
Student Software. 

 
The Class Workspace 

The Class Workspace allows the teacher to see which students are logged in to the classroom network 
and to see which documents have been transferred to/from the handhelds/computer via TI-Nspire 
Navigator. The teacher can also send/collect/delete documents to the class through the Class 
Workspace. Both the Seating Chart View and Student List View of the Class are shown below. 

 

The Class Record is a 
listing of document 
transfers. The teacher 
can also access 
individual student 
information regarding 
a specific transfer. 

  

Student List View of Class 
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The Documents Workspace 

The Documents Workspace is used to create new TI-Nspire documents and to edit or view pre-created 
documents. When working in the classroom with TI-Nspire™ Teacher Software or TI-Nspire Navigator 
Teacher Software, most teachers click on the TI-SmartView™ tab (Tab 3) in the Documents 
Toolbox (left column).  

 

The Documents Toolbox also contains: 

•  (Tab 1) Menu items unique for each application in a TI-Nspire document and question 
properties tools; 

•  (Tab 2) Page sorter; 

•  (Tab 4) Utilities such as math and  symbol templates; 

•  (Tab 5) Content Explorer file transfer tool that allows the user to transfer documents 
to/from the handhelds that are connected to the computer with a USB cable.  
Note:    When using the TI-Nspire™ Navigator™ NC Teacher Software, the Connected 

Handhelds list is not available in the Content Explorer. 

Document Tools Page Sorter Utilities Content Explorer 

    

106



 Tip Sheet: Overview of Workspaces   
TI PROFESSIONAL DEVELOPMENT 

©2013 Texas Instruments Incorporated 5 education.ti.com 

 

The Review Workspace 

The Review Workspace is used after a Quick Poll is sent or a TI-Nspire document containing questions is 
collected using the TI-Nspire Navigator system. The Review Workspace allows the teacher to analyze 
the results of a Quick Poll question or the document question by changing the Data View between a bar 
chart, graph, student work, and/or lists, depending on the configuration and Question Type. 

 

The Review Toolbox contains: 

•  (Tab 1) Menu action items unique for each type of question; 

•  (Tab 2) Page sorter view to browse through the Quick Polls (or document with questions); 

•  (Tab 3) Individual student details for each question. 

Review Tools Students 
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The Portfolio Workspace 

The Portfolio Workspace is used to view previously saved Quick Polls and TI-Nspire document results. 
The teacher can view the summary of scores by student, by question, and by class. 

 

The Assignments Summary allows the teacher to manage the 
scores and files collected using the TI-Navigator System. A 
teacher has the option to review the class results in the Review 
Workspace, to send missing documents, to collect missing 
documents, to redistribute documents to students for further 
work, and/or to open the master document.  

 

A detailed summary of the assignment 
results and student results is available by 
selecting the assignment from the list. 
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TI-Nspire™ Navigator™ Objective 
• Create classes in the TI-Nspire™ Navigator™ System. 

 
Manually Adding Classes 

1. Click the Add Classes icon . Select Manually, and click 
Next. 

 

2. Fill in the field for Class Name as desired. You can have 
multiple sections of the same class name. For example, you 
can have Algebra 1 – 1st Period and Algebra 1 – 2nd Period. 
Click Add after entering each class name. Click Next after 
all the classes have been added. 

3. Click Add Student to manually create student accounts at 
this time. 

• Clicking Finish will create an empty class with the 
desired name. 

 

4. To create student accounts, you must fill in the First Name, 
Last Name, and User Name fields. Students can be 
assigned passwords, or you can allow them to choose their 
own upon their first login. 

• Students can be assigned a Display Name to allow for 
personalization or privacy, and/or Student ID’s can be 
included as necessary. The Display Name defaults to 
the student’s First Name if none is specified. 

• Students can be assigned to multiple classes or moved 
from one class to another by clicking Assign Classes 
and checking the desired class location(s). 

5. Click Add Next Student when finished with the first student. 
Click Finish when you are done adding students to the class. 

 

 

 
 

Importing Classes and Students Automatically from CSV File 

1. Store student information in a spreadsheet application such as Excel and save the file in CSV format. 
You must have a column for the Class Name, Student First Name, Student Last Name, and 
Student User Name. You can also include optional columns for Section, Student ID, and Password. 
The data may be exported from a grade book program or typed manually. The workshop instructor 
will have a sample CSV file. 
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2. Click the Add Classes icon . Select Upload a CSV file, 
and click Next. 

 
3. Click Browse, navigate to the location of the saved CSV file, 

and click Next. 

4. Use the drop-down menus to match up the columns in the 
CSV file to the TI-Navigator fields in the Add Classes by 
Uploading a CSV File dialog box. 

5. Click Next when finished mapping fields. 
 

• If any import errors occur, they will be listed in the details 
on the next screen. The most common error is a 
duplicate username. 

• The CSV file can be modified and uploaded again to 
correct any errors or import new students added to your 
classes at a later date. Alternatively, add the students 
manually. 

 
6. When the CSV file is successfully uploaded, you will receive 

a message that the classes and student profiles have been 
successfully created. 
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TI-Nspire™ Navigator™ Objective 
• Manage classes using the TI-Nspire™ Navigator™ System. 
 
Managing Classes (Hide/show and Delete) 

1. Click Class > Manage Classes to open the Manage 
Classes dialog box. 

• All the classes that have been created on that computer 
will be displayed in the window. 

 

2. Check the box for any class that you would like to hide.  

• Select Actions > Hide, and click Apply. 

• Hidden classes can be retrieved later by returning to 
Manage Classes and changing their status to Show. 

 

Note: Hiding a class will keep the student data attached with 
that class for future record keeping, but will keep that 
class from appearing in the list of active classes. This is 
helpful for schools that require teachers to maintain 
student records for past years. 

 
3. To delete a class, select the check box next to the class, select Actions > Delete, and 

click Apply. 

Note: Be aware that the delete action is not reversible. Deleted classes and student 
data associated with them will be permanently lost. 

 
4. Click OK to exit the Manage Classes dialog box. 
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TI-Nspire™ Navigator™ Objective 
• Review the basic skills needed to use a TI-Nspire™ learning handheld. 

 

Opening a Document 

1.  Power on the TI-Nspire™ handheld, and press c. 

 

2.  Go to My Documents. 

3.    Scroll to the appropriate file using the arrow keys (¤£). 

4. To open a folder, scroll to it, and press ·. 

5.  Scroll to the desired document, and press · or x to 
open the document. 

  

• If the handheld already has a document open, you will 
have to choose whether or not to save changes to the 
prior document. Select Yes or No using the arrow keys 
(or e), and press  x. 

• The desired document is now open. 

 

 
Selecting Answer Choices 

 

1.   To move from the question area to the answer area of a 
question, press e. 

Note: The arrows keys can be used, but the cursor will scroll 
through each line of the question area until it reaches the 
bottom. 

2.  Press e repeatedly to move between the answer choices. 

• The arrow keys can be used here as well.  
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3.  When the desired answer choice is highlighted, press x (or 
·) to mark the answer. 

 

 

Moving between Pages  

The tabs at the top of the handheld screen indicate that the 
document contains multiple pages. 

For example, in the open document shown to the right, the arrow 
to the right of tab 1.3 indicates that there are more than three 
pages in this document. 

1. To move to the next page in a document, press / ¢. 

2. To move to the previous page in a document, press / ¡.  

 
Grabbing an Object 

1. Move the cursor to the graph until the cursor changes to an 
open hand icon (÷). 

2. Press / x to close the hand ({). 

 

3. Use the arrow keys and/or the touchpad to move the object. 

4. Press x to “drop” the object in the desired location. 
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Grabbing and Manipulating a Graph 

1.  Move the cursor to the graph until the cursor changes to the 
dilation symbol õ. 

 

2.  Press / x to grab the graph. 

3. Use the arrow keys and/or the touchpad to manipulate the 
graph. 

4. Press x to “drop” the graph in place. 

 

5.  To translate the graph of a quadratic function, move the 
cursor to the center of the graph near the vertex. When the 
translation symbol ö appears, press / x to grab the 
graph. 

6. Use the arrow keys and/or the Touchpad to translate the 
graph. 

7. Press x to “drop” the graph in place.  
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TI-Nspire™ Navigator™ Objective 
• Use the Live Presenter feature to direct instruction and check for student understanding. 
 

Live Presenter from Class Capture  

1. Open the TI-Nspire™ Navigator™ Teacher Software, and 
start your LCD projector. 

2. Begin Class, and have the students log in to the TI-Nspire 
Navigator class. 

3. Select the Capture icon from the tool bar. 

• Alternatively select Tools > Class Capture, or use the 
computer keyboard shortcut Ctrl+Shift+R. 

 

 

4. Select the Class icon to take a screen capture of the entire class. 

  

5. Click OK. 

• You will see screen captures of the 
class (and they will be projected to the 
class). 
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6. Select a screen capture. The screen will 
have a blue border around it showing 
that it has been selected. 

7. Click Make Presenter. 

• The screen and handheld of the 
selected student only is projected to 
the class as the Live Presenter (as 
shown below). 

 

8. Everything the student does on the handheld is displayed to the class. 

• Rather than the teacher pushing the buttons, he or she can give guided directions 
to the student and have the student go through the motions of the activity. 

• Rotating the Live Presenter during a class period keeps students on task and 
allows the teacher to monitor student progress and understanding. 

Note:  The teacher can customize the layout of the presenter. Currently, the default is to 
show the Handheld and Key Press History. You can turn off either or both of these 
views to customize the Live Presenter. You will see the Key Press History and the 
screen changing in real time. Notice on the Teacher Software that you will see 
each specific button the student presses identified by a red outline. 

            
                Show Handheld and Key Press History                                   Show Handheld Only 

    
            Show Key Press View Only                          Neither Handheld Nor Key Press History 
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9. Click Stop Presenter when a particular 
student is finished as the Live Presenter.  

10. You will be taken back to the Class 
Capture Screen. At this time you can 
refresh screens and select a new student 
to become the Live Presenter. 

 
 

Live Presenter from Classroom View  

1. Open the TI-Nspire™ Navigator™ Teacher Software. 

2. Begin Class, and have the students log in to the TI-Nspire 
Navigator class. 

3. Right-click on a student icon, and select Live Presenter. 

• The student is automatically projected to the class as the 
Live Presenter. 

 
Additional Features of Live Presenter 

1. When the Live Presenter presses a button on the handheld, the button on the picture of 
the handheld is highlighted in RED to show the class which key has been pressed. 

2. The teacher has the following options: 

• Show Keypress History. When selected, the class sees a list of keys the Live 
Presenter has pressed. 

• Show Handheld. Show/hide the graphic of the handheld on the left side of the 
window. 

• Start Recording. Select to start a video recording of what the Live Presenter is 
doing on the handheld. If desired, name the file, and save it on the computer. The 
video is saved as an .AVI file. 
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TI-Nspire™ Navigator™ Objective 
• Use the TI-Nspire Navigator Class Capture feature to check for student understanding. 
 

Viewing Class Screen Captures 

1. Open the TI-Nspire™ Navigator™ Teacher Software. 

2. Begin Class, and have students log in to the  
TI-Nspire Navigator class. 

3. Select the Capture icon from the tool bar, and choose 
Capture Class. 

• OR select Tools > Capture Class. 

• OR use the computer keyboard shortcut Ctrl+Shift+R. 

Note:    When using the TI-Nspire™ Navigator™ NC System, 
only the Capture Class and Capture Page options are 
available. 

 

 

4. Select the Class icon to take a class capture of the entire class, or 
select the Individuals icon to take a screen capture of individual 
students.  

• When using the Individuals option, hold down the Ctrl key to 
select any number of non-consecutive students, or hold down 
the Shift key to select any number of consecutive students from 
the list. 

• When you select the “logged in only” option, only the students 
logged in to TI-Nspire™ Navigator™ System will be displayed. 

• The TI-Nspire™ Navigator™ NC Teacher Software has the 
additional option to “Show TI-Nspire™ Work Area only.” When this 
option is selected, only students’ work areas in the TI-Nspire™ 
Student Software will appear in the class capture. Otherwise, 
students’ entire desktops will be shown. 

 

 

5. Click OK. 

• The student screens will be tiled 
alphabetically according to Display Name. 

• The teacher screen will be identified by a 
blue border (unless the Teacher 
Preferences have been adjusted). 
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6. To refresh the Class Capture, press the Refresh icon. Otherwise, the screens 
are in the same state as when you initialized the Class Capture.   

7. The teacher has the option of choosing whether the student names are displayed with 
the screen captures. 

• Select Show Student Names as desired. 

• Use caution when showing student names in front of the class. The anonymity of 
the screen captures can very important to avoid potential student embarrassment. 

 
 

Class Capture Teacher Preferences 

In the Class Workspace, select File > Settings > Teacher Preferences. 

       

• Toggle the student screen display between alphabetical by display name and 
random distribution with the option “Randomize order in Screen Capture.” 

• Hide/show the Teacher handheld screen with the student screens using the option 
“Individualize Teacher Handheld in Screen Capture.” 

Note:    When using the TI-Nspire Navigator NC Teacher Software, Login information and 
Network Settings are shown instead of the Teacher Account information. The only 
Class Capture option available is “Randomize order in Screen Capture.” 
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Class Capture Features 

Zooming 

• Pressing the Zoom In button enlarges the screens displayed on the 
teacher’s computer. 

 
• Pressing the Zoom Out button shrinks the screens displayed on the 

teacher’s computer. It can be used to return the screens to the 
normal display size. 

• From the View menu, you can select a fixed screen size on the 
teacher’s computer. 

 

           

Saving Screen Captures 

1. Select a screen in the Class Capture window to save. To save 
multiple screens, use the Ctrl key. 

2. Select File > Save Selected Screen(s) to save one or more 
screen captures as a .JPG, .PNG, or .GIF image file (all images 
will be saved in the same format). 

 

 

• Student screens that have been selected will be 
highlighted with a blue shaded border. 

• Only students who are logged in will be saved. 
Even if the Class Capture is showing the “Not 
Logged In” screen, the handheld screens will 
not be saved. 

• The screens will be saved as individual files 
without a student identifier (Image1, Image2, 
etc.). If the purpose for saving is for grading, the 
best option is to print the screen captures. 
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Printing Screen Captures 

• Class screen captures can be printed with the screen identifiers by selecting File > 
Print. The Print Options dialog box allows you to tailor such options as the number of 
screens per page. 

        
 

Reordering Screen Captures 

• Click to drag and drop student screens to new positions within the Class Capture window. 

• Note the difference between the two groups of three screen captures below . 
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Auto-Refresh 

• Once you have taken a Class Capture, click on the Auto-
Refresh drop-down menu to select how often to 
automatically refresh student screens. 

• You can use this feature to monitor student progress by 
setting it to refresh in several time intervals from 30 seconds 
to 10 minutes. 

 

 
 

Changing the View  

• By default, the class capture is in Tiled view. 

• To change to Gallery view, click the View icon and select Gallery (or 
use the computer keyboard shortcut CTRL+G). 

  

• Tiled View allows easy access to a full class set of screen captures. 

 

• Gallery View allows easy comparison of a few screens by selecting them in the gallery 
list on the left using the Ctrl key. 
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Using Screen Stacks 

Teachers might not have time to save individual student screens during 
class. To help with this, a set of Class Captures can be stored as stacks 
of frames as if they are stored on multiple clipboards. A frame is one set 
of class captures. A stack holds multiple frames of class captures. 

1. Click the Add to Stack icon to store the current set of Class Captures. 

 

2. The teacher can Add to Stack multiple times throughout a class session for later review or analysis. 

3. The stacks can be reviewed by clicking the Frame drop-down menu or the Previous Frame or Next 
Frame icons on either side of the drop-down menu. 

 

4. Unwanted stacks can be deleted by clicking the Remove from Stack icon. 

5. Save individual screens from any frame as image files. Select the screen(s) to save, 
and choose File > Save Selected Screen(s). 

6. When the Class Capture window is closed, you will be asked 
whether you want to save the stacks. Click Yes if you want 
to save the stacks of Class Captures. 

• Later, you can go through the stacks of frames for a 
class and save individual Class Capture images. 
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TI-Nspire™ Navigator™ Objective 
• Use the various features of Quick Poll, such as sending, collecting, and reviewing a Quick Poll. 

 

What is Quick Poll? 

An important teaching technique is questioning students during class to gauge their understanding of the 
topics and to ensure that the class discussion is on pace with the students understanding. 

The Quick Poll feature of the TI-Nspire™ Navigator™ System enhances the questioning technique by 
allowing ALL students to answer the posed questions and allowing the teacher to see ALL student 
responses in real time. Then the teacher can make the appropriate reactions/adjustments to the class 
based on the snapshot of student understanding. 

Question Types 

There are various types of Quick Poll questions: 

• Custom Multiple Choice 
• Standard Multiple Choice (A-B, A-C, etc.) 
• True/False 
• Yes/No 
• Always/Sometimes/Never 
• Agree/Disagree (5, 3, or 2 selections) 
• Open Response – Explanation 
• Open Response – Text Match 
• Equations (y= and f(x)=) 
• Expressions 
• (x,y) Numerical Input 
• Drop Points on a Coordinate System 
• List(s) 
• Image (Label, Point on) 
• Chemistry 

 

 

Sending Pre-Made Quick Poll Questions to the Class 

Any question page can be sent as a Quick Poll question. The teacher can create a document ahead of 
class time with questions they anticipate might be helpful to ask students to gauge their understanding of 
a concept. Teachers can decide during class which ones are appropriate to help guide the lesson. 

1. Open the document containing questions for potential 
Quick Poll questions in the Documents Workspace. 
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2.  (Optional) Modify the Quick Poll Options. 

• Allow students access to documents on their handheld. This option is not available when using 
the TI-Nspire™ Navigator™ NC Teacher Software. 

• Allow students to resubmit their Quick Poll answers. 

 

3. After the TI-Navigator class has been started and students have logged 
in to class, the current question being viewed in the Documents 
Workspace can be sent as a Quick Poll by clicking the Start Poll icon.  

 

4. When all students have answered the question, click the Stop Poll icon. 

 

Sending “On-The-Fly” Quick Poll Questions to the Class 

1. After the TI-Navigator class has been started and students have logged in 
to class, click the Quick Poll icon.  

2. Select a Question Type, and press Insert. 

• If this is the first Quick Poll question of the TI-Navigator 
session, a new document will open in the Documents 
Workspace titled “Class Name – QP Set # – Date”. 
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3. (Optional) Enter the question into the text box, and select/enter answers when appropriate. 

      

4. (Optional) Modify the Quick Poll Options. 

• Allow students access to documents on their handheld. 

• Allow students to resubmit their Quick Poll answers. 

 

5. Send the question to the class by clicking the Start Poll icon.  
 

6. When all students have answered the question, click the Stop Poll icon. 
 

 
Responding to Quick Poll Questions as a Student 

1. After the teacher has started the Quick Poll question, all 
students who are logged in to the class will automatically 
receive the question on their calculators as a pop-up 
window. 

• If a student logs into the class after the poll has been 
sent, they will receive the poll as long as the teacher 
hasn’t click the Stop Poll icon.  

2. For multiple choice questions, students move through the answer choices by pressing e (or ¤). 
To select an answer, they press x or ·. 

3. For other types of questions, students enter the answer using the appropriate keys and templates on 
the handheld. 
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4. To send the answer response to the teacher’s computer, 
students press ~ > Submit. 

 

 
5. If the Allow Resubmit option was selected by the teacher, 

students can change their answers and resubmit by pressing 
~ > Resubmit. 

Note:  If the resubmit option is not selected, the question will 
disappear from the handheld once the answer has been 
submitted. 

 
6. If the Allow Document Access option was selected by the 

teacher, students can temporarily exit the Quick Poll to look 
at a document by pressing c or ». 

• To return to the Quick Poll question, select Quick Poll 
from the Home screen. 

Note:    When using the TI-Nspire Navigator NC Teacher Software, 
the “Allow Document Access” option is not available. By 
default, students will have access to all documents and 
applications on their computers during a Quick Poll. 

 

 

Pausing/Resuming Class 

When students are having trouble with a Quick Poll question, the teacher might find it useful to gain the 
students attention by preventing them from interacting with their handheld, i.e., pausing the class. The 
Pause Class option will prevent any interaction with the handhelds. 

1. To pause the class, click the Pause Class icon, which is located 
by the class drop-down menu.  

• When a class is paused, the students receive a 
message on their handhelds. 

 

 

 

2.  To resume the class, click the Resume Class icon.  
• Students are once again able to interact with their handhelds.  
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Viewing Quick Poll Results 

The teacher can view the results of a Quick Poll while students are submitting their responses or after the 
Quick Poll has been stopped. 

1. As soon as the Quick Poll is sent to the class, the software automatically changes to the Review 
Workspace and displays the Quick Poll question that was sent to the class. 

Note: The first 15 Quick Poll questions of the class session will be stored in a single Review document. 
After the 15th question, a new Review document will start for the next 15 Quick Poll questions. 

2. To view the class results for the Quick Poll questions, click on the 
Student Data icon underneath the Question page in the Page Sorter 
view. Alternatively, scroll down using the scroll bar to the right of the 
large view of the Quick Poll question (see below right). 

 

      

3. When all students have answered the question (or you are satisfied that a 
sufficient amount of time has passed), click the Stop Poll icon.  

4. If you did not select the correct answer in the Question page prior 
to starting the poll, right-click on the correct response, and select 
Mark this Response Correct. 

• The bar next to the correct answer will turn green, indicating 
that it is the correct answer.  

• To view the student-submitted answers in 
detail, click on the Students icon in the Review 
Toolbox.  

• The display name and response are shown in 
a table. 

• The poll details can be sorted by display 
name, by response, or by time. Click the top 
of the desired column to sort. 

• To hide the student names, click the Student 
Name Format icon and select <hidden>. 
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Additional Data Views for Quick Poll Results 

When the Student Data icon is selected, most of the results are displayed as a bar chart by default. 
Depending on the type of Quick Poll question, the results can be displayed in a variety of data views. 

Data Views for Multiple Choice and Open Response Questions 

           Bar Chart             Frequency Table  

           
Data Views for Equation Questions 

Bar Chart  

        

     Graph       Show Work      Frequency Table  
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• The Show Work Data View is available when Allow students to show their work is selected 
before sending the Quick Poll. 

Data Views for Coordinate Points & List(s) Questions 

        Bar Chart          Graph   Frequency Table  

           

Graph Data View Options 

The Graph Data View can be modified using the options in the Review Tools pane  of the Review 
Toolbox (the left column). Options include, but are not limited to, changing the window settings, adding a 
teacher point/equation, and individualizing student responses. Some of the options are available by right-
clicking on the graph. 
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Viewing Previous Quick Poll Questions 

The Page Sorter view in the Review Toolbox allows the teacher 
to re-display previous Quick Poll questions for discussion.  

1. Click on the Page Sorter pane in the Review Toolbox. 

2. Scroll to the Student Data icon below the Quick Poll question you 
want, and click to view the student responses. 

 

 
Saving Poll Results 

The results from all Quick Poll questions sent during a class 
session are compiled in a Review Document and can be saved 
for review at a later time. The results will be placed in the 
Portfolio for the class.  

1. Click the Save icon. 

Alternatively, select File > Save to Portfolio.  

 

 

 

      

 

2. If desired, enter a name to identify the Quick Poll results other 
than the default name, or add the results to an existing 
portfolio column (see the Portfolio Workspace capture to the 
right; each column is a Quick Poll or Collected Assignment). 

 
Note: The first 15 Quick Poll questions of the class 

session will be stored in a single Review 
document, even if polls are sent after saving 
the Review document to the Portfolio. After 
the 15th question, a new Review document 
will start for the next 15 Quick Poll questions. 

3. If the Review document is not saved before 
ending the class, the teacher will be prompted 
to save when the software is closed. 
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TI-Nspire™ Navigator™ Objective 
• Send documents to students using the TI-Nspire™ Navigator™ System. 
 
TI-Nspire™ Navigator™ Features 
• Sending Documents  
• Student Retrieval of Documents 
• Verifying Transfer of Documents to Students 
 
Sending Documents 

1.  Open the TI-Nspire™ Navigator™ Teacher Software. 
2. Begin Class, and have the students log in to the TI-Nspire Navigator class. 
3. Click on the Send to Class icon.  
4. Locate and select the documents you want to send to the class. 

• Use the Ctrl key on your keyboard to select nonconsecutive documents from a list.  
• If you would like to send an entire folder, click on the Folders tab, and select the 

folder to be sent to the students. 

   

5. Click Next. 
6. Select Class Send or Individual Student(s) Send. 

• If you would like to send to a subset of students only, highlight all of the desired 
students by holding the Ctrl key and clicking their names with your mouse. 
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7. The selected folder or document(s) will be sent to the student devices. 
• The default folder to which the document will be sent is My Documents > TI-

Nspire > Class Name {the name of the class you created in TI-Navigator}. 
8. Click Finish. 

• You will see the sent document(s) listed in the Class Record. This line will also 
show how many students have received the documents. 

 
 
 
Student Retrieval of Sent Documents 
The students will receive the documents automatically upon log in. 

• All students who are already logged in to the TI-Nspire Navigator classroom when 
your send the documents will automatically receive the documents. 

• Students who have not yet logged in to the TI-Nspire Navigator class will receive 
the documents as soon as they log in to the class. 

 
 
Verifying Transfer of Documents to Students 
1. Select the document to be verified in the Class Record. 
2. A color code system the Student View of the class indicates 

whether a student has successfully received the document(s). 
• If the document(s) was successfully received by the 

student, then the box will be green. 
• If the document(s) was not received by the student, then 

the box will be red. 

 
 

 
 

 
Sending Documents Using the TI-Nspire™ Navigator™ NC System 
Any type of document can be sent to students’ computers using the TI-Nspire™ 
Navigator™ NC Teacher Software, even though students can only open TI-Nspire™ 
documents and PublishView™ documents in the TI-Nspire™ Teacher Software.  
All other documents can be opened in their native applications. 
 
All documents sent using the TI-Nspire Navigator NC Teacher Software will be located in 
the TI-Nspire class folder on students’ computers. 
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TI-Nspire™ Navigator™ Objective 
• Collect document from students using the TI-Nspire™ Navigator™ System. 
 
TI-Nspire™ Navigator™ Features 
• Collecting Documents 
• Student Transfer of Documents 
• Verifying Transfer of Documents from Students 
 
 
Collecting Documents from Students 
1.  Click the Collect from Class icon. 

  
2.  Select the file(s) to be collected, and click Next. 

• If you want to collect more than one file from the students, use the Ctrl key on your 
keyboard as you click the files in the list. 

• If you want to collect a file you recently sent to the class, click Recent Files, and 
the files that have been recently sent will be listed for your convenience. 

 
 
3.  Select Class, or select individual student(s) by clicking 

Individuals, using the Ctrl key to select nonconsecutive 
students from the list. 
• By choosing to collect from the entire class with the 

“Logged in only” option selected, you will only collect the 
file(s) from students who are currently logged in to the 
class. 

4.  If you want to delete the file from the student device, select 
the “Delete from student after collecting” option. 

5. Click Finish. 
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• You will see the collected and deleted file(s) listed in the Class Record list on the  
TI-Nspire Navigator Home Screen. 

• This line will also show how many of the students’ files have been received. 

 
 
Collecting Documents Alternative 
1. From the Class Record, right-click on the document to be collected. 
2. Select Collect Selected from class. 

 

• The documents will automatically be collected from the class. 
Note:  There is no option to delete documents at the time of collection using this method. 

The teacher could use Delete from Class at a later time during the class session. 

Verifying Collection of Documents from Student Computers 
From the Class Record, select the file to be verified. The Student View of 
the class will indicate whether a document has been collected successfully. 

 
• If the document was collected successfully, then the box will be green. 
• If the document has not been collected, then the box will be red. This might be 

because the student is not logged in to the TI-Nspire Navigator class. 
• If the document was not in the student’s class folder, then the box will be yellow. 

 
Collecting Documents Using the TI-Nspire™ Navigator™ NC Teacher Software 
Any type of document can be collected and saved to the Portfolio using the TI-Nspire 
Navigator NC Teacher Software. For a non-TI-Nspire document, students must save their 
work before the teacher collects the document. Once a non-TI-Nspire document has been 
collected, it can be viewed or edited in its native application by going to the Portfolio 
Workspace, right-clicking the document, and selecting “Open for Editing.” 
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Unprompted Documents from Class 
Students can send documents to the teacher without the teacher collecting from the class. 
When this happens, an unprompted file folder with the sent date will appear in the class record. 

 

• The number in the status column tells the teacher how many documents have been 
sent to the Unprompted folder. 

• Double-clicking on the Unprompted folder will open a window. 

 

• The teacher can select all the document of an individual student by clicking the 
checkbox in front of the document. 

• Once you have selected the documents from the Unprompted folder, options at the 
bottom of the window become active. 

 

View: This option opens the document(s) in the Teacher Software. 
Export: This option allows the teacher to save the document to any location on the computer. 
Remove: This option deletes the document from the Unprompted folder. 
Save to Portfolio: This option allows the teacher to create a new column in the Student 
Portfolio or add the document(s) to a current column. 
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TI-Nspire™ Navigator™ Objectives 
• Send documents to handhelds using the Transfer Tool. 

• Delete all folders on connected handheld(s). 

 

Send Documents to Connected Handhelds 

1. Open the TI-Nspire™ Navigator™ Teacher Software. 

2. Select Tools > Transfer Tool (or use the keyboard shortcut 
Ctrl+Shift+T). 

• The Transfer tool is not available when a class is in session. 
 

3. Click the Add to Transfer List button, and browse on your computer for the 
documents(s) to be transferred. 

• You can send an entire folder by clicking on the Folders tab and selecting the 
folder to be sent to the students. 

   

4. You can change the folder to which the document(s) will be 
sent on the handheld. 

• The default folder is “Transfers-Date”. 

• Edit the destination folder by clicking on the Destination 
Folder name and entering the name of the new 
Destination Folder. 

• Click Change.  

5. Click Start Transfer. 

• The Transfer Tool Status window will indicate the status 
of the document(s) being transferred to individual 
handhelds. 

6. When the file transfer is complete, click Stop Transfer and 
Close. 
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Delete All Documents and Folders on Handheld 

1. Open the TI-Nspire Navigator Teacher Software. 

2. Select Tools > Transfer Tool (or use the keyboard shortcut 
Ctrl+Shift+T). 

• The Transfer tool is not available when a class is in 
session. 

3. Check the box to select “Delete all files and folders before 
transfer.” 

• If desired, add files to send to the handheld using the 
steps above. The files will be transferred to the handheld 
after all files and folders have been deleted. 

 

4. Click Start Transfer. 

• A confirmation message will appear. Click Yes to continue with the delete. 

 

• The Transfer Tool Status window will indicate the status of the folders and files 
being deleted to individual handhelds. 

 

5. When the file transfer is complete, click Stop Transfer and Close. 

6. The connected handhelds will contain no documents or 
folders except the My Documents folder. 
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TI-Nspire™ Navigator™ Objective 
• Send an Operating System (OS) to handhelds using TI-Nspire™ Navigator™ Teacher Software. 

 

1. Download the current OS to your computer. 

• Visit www.education.ti.com to download the latest OS for  
TI-Nspire CX, TI-Nspire, TI-Nspire CAS CX, and/or TI-
Nspire CAS. 

• Select Downloads & Activities > Apps, Software & 
Updates.  

 

• From the drop-down menus, select the appropriate 
technology and Handheld Operating System. Then click 
Find. 

• Select the name of the appropriate handheld. 

• Select Save, and browse to a convenient download 
location on your computer, such as your Desktop. 

 

• Alternatively, use Quick Links to access and save the 
latest OS. 

 

2. Open the TI-Nspire Navigator Teacher Software. 

3. Select Tools > Transfer Tool (or use the keyboard shortcut 
Ctrl+Shift+T). 

• The Transfer tool is not available when a class is in 
session.  
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4. Click Add to Transfer List, and browse on your computer for the OS file to be 
transferred. 

• You can select Operating Systems for each type of handheld. 

• If your class has more than one type of handheld, the Transfer Tool will update 
each handheld with the proper OS. 

 

5. Click Start Transfer. 

• The Transfer Tool Status window will indicate the OS being transferred to individual 
handhelds. 

6. When the file transfer is complete, click Stop Transfer and Close. 
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Activity Overview 
Create a custom TI-Nspire question document from pre-made State assessment documents found online. 
 
 
Materials 

• Internet access 
 
 
 
Downloading State Assessment TI-Nspire Documents 

Released State Assessment questions are available online for many States, already 
formatted as questions in TI-Nspire documents. Teachers might want to use some of these 
Question pages from a large State assessment document for formative assessment or for 
student practice. 

1. Open the web site education.ti.com. 

2. At the bottom of the page, click on TI in your State.  
3. Click on the desired location on the map. 

Note: This example uses a document with practice exam 
questions from Texas. 

4. Under the Download section, click on one of the Practice 
Exam links.  

 
5. Select a document to download, and click on that document. 

• TI-Nspire documents have the extension .tns. 
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6. When the File Download dialog box appears, click Save 
to save the document. 

7. Select the Desktop as the location to which the document 
should be saved. 

 
• The TI-Nspire document icon with the file name will be 

located on the desktop. 
 

Opening State Assessment Document 

1. In the Documents Workspace, click on the Open a document icon . 

• Alternatively, select File > Open Document. 

2. In the Open dialog box, click the Home icon  to access the computer Desktop. 

3. Click on the TI-Nspire document you just downloaded, and then click Open. 

Note:  If the Page Sorter pane in the Documents Toolbox is not displayed, select it. 

 

4. Use the scroll bar in the Page Sorter view to scroll through and preview the questions 
in the document. 

• Alternatively, click on a page in the Page Sorter view and arrow up or down to 
preview questions. 
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Copy/Paste Questions to a New Document 

1. To select a question to be included in your custom 
assessment document, right-click on the question page in 
the Page Sorter view, and select Copy. 

• Alternatively, click on the question page in the Page 
Sorter view, and press Ctrl+C on your keyboard. 

 

 

 

 

 

 

2. Select File > New TI-Nspire Document. 

• A new document will open in the Page Sorter view.  

3. Right-click on the page in the Page Sorter view, and select 
Paste. 

• Alternatively, click on the page in the Page Sorter view 
and press Ctrl+V on your keyboard. 

 

  

• The pasted question page is inserted after the first, blank 
page of the new document. The first page can be used to 
provide directions for the students, or it can be deleted. 

 

 

 

 

 

 

 
4. Return to the state assessment document by clicking on the 

document name at the bottom of the screen. 
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5. Select another question page in the Page Sorter view of the state assessment 
document.  Right-click on that page, and select Copy. 

6. Click on the tab for the new document - Document2, in this example. In the Page Sorter 
view of the new document, right-click on the last page, and select Paste. 

7. Repeat steps 4 through 6 to copy as many questions to the new document as desired. 

Note: The order of the questions can be changed by dragging and dropping the question 
pages in the Page Sorter view. 

8. When finished, press Ctrl+S to save the new document. Enter a name, and choose a 
location for the new document. 

 

Adding Instructions to the New Document 

1. To make the first page of the new document a Notes 
application page to provide directions, click on that page in 
the Page Sorter view. 

2. Click in the large version of the page in the right work area. 

3. From the list of applications, select Add Notes. 

4. Enter the desired text. 

Note: To delete the first page of the new document, right-click on 
the page in the Page Sorter view. Select Cut or Delete. 
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Activity Overview 
The Press-to-Test feature enables you to quickly prepare student handhelds for exams by temporarily 
disabling folders, documents, and select features and commands. This activity enables Press-to-Test. 
To disable Press-to-Test, you will need to follow Steps 8-9 using either an additional TI-Nspire handheld 
or a computer with the TI-Nspire Teacher Software. 
 
 

Materials 

• TI-Nspire™ handheld-to-handheld or handheld-to-computer USB connection cable  
 

 

Step 1: 

To enable Press-to-Test on the TI-Nspire™ with Touchpad and TI-
Nspire CX™, first ensure that the handheld is turned off. Press 
and hold d and c until the Press-to-Test screen appears. 

Note:   To enable Press-to-Test on TI-Nspire™ with Clickpad, 
press and hold d, c, and w. 

 

 

 

Step 2: 

By default, Press-to-Test disables 3D graphing and pre-existing 
Scratchpad data, documents, and folders. The angle settings can 
be changed by pressing ¢, selecting the appropriate setting, and 
pressing ¢ or ·. 

By default, all of the commands and features listed are disabled. 
To enable a feature or command, uncheck its box. Keep all boxes 
checked. Enter Press-to-Test by clicking Enter Press-to-Test. 

 

 

 

Step 3: 

Once the handheld is in Press-to-Test mode, the handheld 
reboots. A dialog box confirms that the handheld is in Press-to-
Test mode and the restrictions are listed. Click OK. 

 

Step 4: 

When in Press-to-Test mode, the LED at the top of the handheld 
begins blinking. Green indicates that all restrictions are selected 
(default), while yellow indicates that one or more restrictions are 
unselected. During the initial reboot, the LED alternates between 
red and, depending on the restrictions, either green or yellow.  
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Step 5: 

Create a new document, add a Geometry page, and press b. 
Since geometry functions are limited, observe that the 
Measurement, Construction, and Transformation menus are 
not accessible. 

Note: The lock icon at the top of the screen indicates that the 
handheld is in Press-to-Test mode.  

Step 6: 

Add a Calculator application by selecting ~ > Insert > 
Calculator. Type cot(π/2) and press ·. Since trigonometric 
functions are limited, an error message appears. The dialog box 
tells students how to access additional information about the 
restrictions. Click on OK. 

 

Step 7: 

Select c > My Documents. While in Press-to-Test mode, a 
Press-to-Test folder appears in My Documents. All other folders 
and documents present on the handheld before Press-to-Test 
mode was entered are inaccessible. 

Step 8: 

To exit Press-to-Test mode, connect two handhelds using the 
handheld-to-handheld USB connection cable. Then select ~ 
> Press-to-Test > Exit Press-to-Test. The Exit Press-to-Test 
option appears regardless of whether the other handheld is in 
Press-to-Test mode. 

Press-to-Test can also be exited with the TI-Nspire™ Navigator™ 
Teacher Software. Once a class has been started, students can 
select ~ > Press-to-Test > Exit Press-to-Test. 

 

 

Step 9: 

Press-to-Test can also be exited with TI-Nspire Teacher 
Software or TI-Nspire Navigator Teacher Software by creating a 
document named Exit Test Mode.tns and transferring it to 
connected handhelds. 

Note:    The name of the TI-Nspire document must be spelled 
exactly as it is above. 

 

Go to the Tools menu and select Transfer Tool. Click Add to Transfer List and select 
Exit Test Mode.tns. In the Edit Destination Folder, select the Press-to-Test folder and click 
Change. Then, click Start Transfer. 
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Rating Scale: 0 – Not covered yet 
1 – Uncertain – need more instruction 
2 – Moderate – need more practice 
3 – Average – comfortable 
4 – Good – competent 

 
TI-Nspire™ Navigator™ Skill Day 1 Day 2 Day 3 

Class Workspace: 

• Create a Class    

• Add/Modify Students    

• Teacher Preferences    

Class Capture:  

• Auto-Refresh Class Capture    

• Zoom In/Out    

• Reordering Screen Captures    

• Saving Screen Captures    

• Screen Stacks    

Live Presenter    

Document Management: 

• Send to Class    

• Collect from Class    

• Delete from Class    

• View files collected from class    

• Save to Portfolio    
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Quick Poll: 

• Multiple Choice    

• Open Response    

• Equations    

• Coordinate Points & Lists    

• Image    

• Chemistry    

• Review Student Data    

Review Workspace: 

• Mark Correct Answer(s)    
• Change Data View for appropriate 

question types    

• Data Aggregation    

Portfolio Workspace: 

• Edit Scores    

• Send Missing Documents    

• Collect Missing Documents    

• Redistribute Documents    
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